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Have you heard of the term ‘life laundry’? 
It’s a horrible buzzphrase for sure, but the 
meaning behind it – about getting rid of 
things that are holding you back – has 
resonated with me recently. I’m in the 
middle of a house move, so at the 
moment my life is a whirl of boxes, 
bubble wrap and packing. What’s struck 

me most about this impending shift across town is just how many 
things I’ve accumulated. I’m no hoarder, but I’d kept things simply 
because there was a cupboard space, or shelf for them to be plonked 
on to. As soon as I was faced with the prospect of lugging all of 
these things across town, I quickly worked out what was essential to 
take, and what wasn’t going to make the trip. 

Could you say the same for your home, studio or art? My clear-out 
is about possessions, but it doesn’t have to be something physical. It 
could be how you approach an image, or whether you hold on to an 
art style that doesn’t suit how you paint. Maybe you have an 
unfinished piece that consumes your mind, to the point that you’re 
unable to let anything fresh or new in its place? 

Have a think about the things you do out of habit, or keep hold of 
simply because there’s space for it. You’ll feel better after letting 
things go – and perhaps have a new respect for what’s left behind.  

Also, don’t miss our special digital edition offer. Get a free Apple 
Newsstand or Google Play Store version of this issue free and enjoy 
the features of our digital edition. Turn to page 27 for details.

Editor’s letter

November 2014 3

Our special cover for 

subscribers this issue.

to taking the weight off
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Sketchbook: Miles Johnston

The art of imitation Artist in residence Q&A: Bouncing object

Q&A: Flying creaturesQ&A: Hands

Q&A: Nervousness

“Photoshop has brought all the 
tools of a pro artist to anyone  
who can get their hands on it”
Tony Foti on the merits of Adobe’s big hitter
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Getting your hands on all of this issue’s videos, 
artwork and brushes is quick and easy. Just visit our  
dedicated web page at http://ifxm.ag/alien114skin
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workshop video

of workshop and Q&A videos to watch and  learn from!

over  8 hours 

get your 
resources

Draw and paint 
a female face
Charlie Bowater reveals how she 
introduces otherworldly elements 
into her beautiful female portrait.

You’re three steps away from 
this issue’s resource files…

1Go to the website
Type this into your browser’s 

address bar (not the search bar): 
http://ifxm.ag/alien114skin

2Find the files you want
Search through the list of 

resources to watch or download.

3Download what you need
You can download all of the  

files at once, or individually.

media://vod.creativegroup.futurecdn.net/GmoU0d00uUSQ7.mp4
mailto:?subject=Workshop%20files%20for%20ImagineFX%20issue%20114&body=Hello%20reader%0A%0APlease%20email%20this%20message%20to%20yourself%20and%20open%20it%20on%20your%20desktop%20computer%20or%20laptop%20%0A%0AThen%20click%20the%20specific%20links%20to%20download%20the%20workshop%20resource%20files%20from%20this%20issue%0A%0AAlternatively%20you%20can%20visit%20http://ifxm.ag/alien114skin%20where%20you%20will%20find%20video%20downloads%20as%20well%20as%20links%20to%20all%20of%20the%20assets%20from%20this%20issue%0A%0AWorkshop%20files%0A%0ADraw%20and%20paint%20a%20female%20face%0Ahttp://mos.imaginefx.com/UNI114-female-face.zip%0A%0AComposition%20myths%20and%20methods%20%0Ahttp://mos.imaginefx.com/UNI114-composition-methods.zip%0A%0APaint%20an%20exotic%20market%20scene%0Ahttp://mos.imaginefx.com/UNI114-market-scene.zip%0A%0ATexture%20tips%20in%20Painter%0Ahttp://mos.imaginefx.com/UNI114-texture-tips.zip%0A%0ASculpting%20the%20perfect%20portrait%0Ahttp://mos.imaginefx.com/UNI114-sculpt-a-portrait.zip%0A%0APainting%20an%20original%20dragon%0Ahttp://mos.imaginefx.com/UNI114-paint-a-dragon.zip%0A%0ACreate%20mood%20with%20value%20composition%0Ahttp://mos.imaginefx.com/UNI114-value-composition.zip%0A%0AAll%20workshop%20assets%0Ahttp://mos.imaginefx.com/UNI114-Workshop-assets.zip


Issue 114 November 2014

November 2014 7

Te Hu
Discover how to mix digital watercolours in Corel Painter and then let your emotions 
guide your use of colours and shapes as you sculpt a fantasy figure on the digital canvas.
Plus WIPs and final art

Nikolai Lockertsen
Use Procreate to paint an exotic street 
market scene on your iPad. 
Plus WIPs and final art

Naiha Raza
Ensure that your human characters have 
realistic-looking hands and arms. 
Plus WIPs and final art

Sara Forlenza
Learn how best to depict the motion  
of a small, bouncing object
Plus WIPs and final art

John Petersen
Capture the look of extreme pain without 
looking at reference images.
Plus WIP and final art

John Petersen
Make your human characters break out 
into a cold sweat with John’s advice. 
Plus WIP and final art

Paco Rico Torres
The secret to painting life-like burn 
injuries… is studying a pepperoni pizza!
Plus WIPs and final art

Bryan Wynia
If you’re keen to create fantasy creatures in 
ZBrush then this instructional video by 
CDW Studios, is worth a look..

40 CUSTOM BRUSHES, including…

over  8 hours 

Exclusive video tuition!
Watch our videos to gain a unique insight into how our artists create their stunning art

subPaint
Charlie Bowater paints a lot of her 
figures with this soft chalky brush.

Skin Pores
This is a great skin texture brush for 
recreating pores, says Charlie.

Dons Brush
Don Seegmiller uses this brush for 
general sketching and painting.

PLUS Watch Sara Forlenza’s video on painting a realistic stone character, plus WIPs and final art from this month’s expert artists, 
including Nick Harris, James Gurney, Don Seegmiller, Mark Molnar and Eric Velhagen.

WORKSHOP videos

Q&A videostraining

media://vod.creativegroup.futurecdn.net/h3dFqzm27DP56.mp4
media://vod.creativegroup.futurecdn.net/7e5d63rL61Rag.mp4
media://vod.creativegroup.futurecdn.net/1ikm6iwKH433k.mp4
media://vod.creativegroup.futurecdn.net/4w32d002159J6.mp4
media://vod.creativegroup.futurecdn.net/5gBhwmcQ7439X.mp4
media://vod.creativegroup.futurecdn.net/p8LiI9U953Ml2.mp4
media://vod.creativegroup.futurecdn.net/P28lsAMyoQ2Ns.mp4
media://vod.creativegroup.futurecdn.net/Y7jEzDGr9n0nT.mp4
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the place to share your fantasy art

1v “This piece took around two hours. 
It was inspired by an anonymous 

photo I found online. It had a similar 
mood, but the girl was younger. I was 
aiming for a futuristic mood. I’m sure 
strong female characters are an 
inspiration for many digital artists.”

Artist of the month
Congratulations Klaus – you’ve won 
yourself a copy of Exposé 11 and 
d’artiste: Character Design! To find out 
more about these two great books, go 
to www.ballisticpublishing.com.

Klaus Wittmann
Location: Poland
Web: http://ifxm.ag/kwittmann
Email: johnnyslut666@gmail.com
MEDIA: Photoshop

Klaus’s work is “dark and 
confusing, full of filthy, 
destroyed places and 
strange characters.” The 
Polish artist lives and 

studies in Łódz, which he says has a 
great influence on his art. It’s a city “of 
post-industrial factories and abandoned 
buildings, all with a befouled mood.”

The artist works as a full-time 
freelancer, and is busy producing art for 
a top-secret Hollywood project.

´
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Concept artist Donglu 
Yu likes the light and 
shade in Klaus’s work

“The sadness in her 
eyes immediately 
seized me. 
Conveying 

emotion is such a hard 
task in portrait paintings, 
but the artist has 
accomplished it with 
brilliance. I also enjoy 
the brushwork on the 
character herself, 
combined with the 
treatment of the camera-
lens-blurred background.”
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Gabriel Iumazark
Location: Brazil
Web: www.iumazark.deviantart.com
Email: gaz.desenhos@gmail.com
MEDIA: Photoshop

Gabriel’s deviantART 
profile is closing in on one 
million page views. He may 
attract much attention 
online, but in person the 

Brazilian artist prefers to keep a low 
profile: “I’m a vegetarian and coffee 
addict; a simple guy, rarely seen at 
public events – almost a hamster, really.” 

Much of Gabriel’s work is mixed 
media, using mechanical pencils before 
moving art into Photoshop. Recent 
projects include The Last Broadcast, an 
ongoing “urban exploration adventure” 
comic series, which Gabriel draws and 
Brazilian André Sirangelo writes.

1Fem-Cabisle “Fem – seen in this 
piece – is my muse. She’s present in a 

lot of my personal works, mostly as a 
fashion model.”

2YOGI “I would describe Yogi as a 
droid-like dancer. I created this 

piece as part of a commission – starting 
with pencils and then moving onto the 
digital canvas, as I always do.”

3The Last Broadcast - Cover 
One “This is the first cover of The 

Last Broadcast, a comic written by 
Andre Sirangelo and drawn by myself.”

1

2 3
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Daniel Strange
Location: England
Web: www.thinkstrange.co.uk
Email: info@thinkstrange.co.uk
MEDIA: Photoshop

Daniel describes his 
passage into illustration as 
something of a sidestep. 
“Following a fine art 
degree, I was caught in a 

dead-end media post-production job. I 
was quite handy with a pencil so I worked 
my way into storyboarding and then, 
from there, into illustration.”

The London-based illustrator 
describes his work as borrowing from 
“classic illustration and design of the 
40s, 50s and 60s.” 

1Night of the Three-Headed 
Beast “This was my cunning way of 

including each of three bands playing a 
Halloween gig, so that they all got equal 
billing on the poster.”

2Sons of Kemet – Burn “I was 
asked to produce something that 

touched on the Egyptian influence of the 
band’s name. The apocalyptic, dystopian 
pyramid is the result.”

3Empirical – Elements of Truth 
“I really enjoyed picturing each of the 

band members as one of the classical 
elements – earth, wind, fire and water 
– as suggested by the album’s title.”

1

3

2
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Jian Yi-mi
Location: Taiwan
Web: www.meammy.deviantart.com
Email: meammy84124@gmail.com
MEDIA: IllustStudio, Photoshop

Jian is an 18-year-old artist 
who’s been drawing 
digitally for just three 
years. The Taiwanese 
student has already 

developed a unique style, mixing Pixar 
and DreamWorks influences with a 
touch of the macabre – gas masks and 
guns being among some of her favourite 
items to draw. 

“Some of my works reflect my mood, 
and drawing is a way to release stress,” 
Jian says. “Most of my works are 
inspired by music, especially dark music. 
I like creepy and cute things; some of 
the girls in my artworks come under 
both descriptions.”

1You Lost One Eye “I always have 
ideas for stories, and when they  

come I try to draw a scene from the 
story I’m thinking of.”

2Trauma “This artwork is influenced 
by my mood at the time. I was very 

unhappy when I was drawing this piece. 
During the drawing process, I added the 
background to the starry sky because  
I felt better.”

3Untitled “This is a lighting 
practice piece. The girl is a character 

for a story I’m planning.”

4Waiting! “Initially, I was trying to 
draw a nurse in black. Then I was 

influenced by the music that was on in 
the background (City of Angels by 30 
Seconds to Mars, since you ask).”

1

2

3
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IMAGINEFX CRIT
“A muted colour 
palette and a cast  
of characters who 

appear to have escaped 
from the land of The Dark 
Crystal makes for an 
absorbing, slightly 
disturbing portfolio. 
Which was probably  
Jian’s intention all along.” 
Cliff Hope,
Operations Editor

4



Randy Toroni
Location: US
Web: www.randytoroni.com
Email: www.ryonokk@gmail.com
MEDIA: Photoshop

Randy grew up in Eureka, 
Northern California, where 
George Lucas shot scenes 
for the forest moon Endor 
in Return of the Jedi. 

Computer games also had a big effect 
on his childhood, and Randy’s earliest 
memories are of drawing Mario, Sonic 
and Final Fantasy characters. 

“I didn’t get serious about art until  
I got into art school,” says the concept 
artist who’s now living in Los Angeles.  
“I had some ups and downs, discovered 
that art school isn’t everything, and that 
I’m the only person in charge of making 
sure my dreams come true.”

14 November 2014 Email your submissions to fxpose@imaginefx.com

1Bahamut “This image is my own 
personal take on Bahamut from Final 

Fantasy. I wanted it to look like a dragon 
god that was both ferocious and grand.”

2LC Mecha Suit “This character is a 
champion I designed for League of 

Legends called Tera: The King Slayer. It 
was a fun exercise and I intend to do 
more figure designs.”

2

1
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Brad Wright
Location: England
Web: http://ifxm.ag/b-wright
Email: bwconcept@hotmail.co.uk
MEDIA: Photoshop

Brad is a concept artist 
plying his trade at British 
game developer The 
Creative Assembly, where 
he’s busy working on 

upcoming SEGA game Alien: Isolation. 
“I nearly always start on paper,” he says. 
“In many of the paintings, whole 
portions could be hours of graphite or 
ink work, before going digital.”

The Northern Irishman, now based in 
the West Sussex market town of 
Horsham, says as a concept artist he’s 
influenced by sci-fi, particularly 
cyberpunk. “I also fancy myself as fine 
artist,” Brad says, “and look for 
guidance and inspiration in the likes of 
Sargent, Repin, Fechin, as well as 
contemporary artists such as Alex 
Kanevsky, Joao Ruas, Kent William and 
Kevin Llewellyn.”

1Painting 102 “A painting that  
I produced recently on the day I 

turned 30. Not the most enjoyable of 
milestones, and this is reflected here. It 
was also an attempt to push my 
brushwork further digitally. How far 
could I go with nothing but two or three 
brushes to choose from?”

2Painting 171 “Part of a series of 
work I created during a transitional 

phase in my life and career. I was 
obsessed with the idea of getting old 
and having the time to explore all that I 
needed to experience. These spacemen 
are somewhat self-referential, both in 
the subject matter and the 
experimental nature of the painting.”

3Painting 104 “I tend to draw skulls 
more than anything in my personal 

work, usually in my sketchbook, and 
sometimes developed further digitally.  
I have a large collection of various 
shaped and conditioned skulls at home 
to keep me inspired.”

1

2

3
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Gianluca Mattia
Location: Italy
Web: www.gianlucamattia.com
Email: info@gianlucamattia.com
MEDIA: Photoshop, Cinema 4D

“Eroticism, madness, 
perversion and comedy 
make up the world of 
Gianluca Mattia,” said 
Tattoo Italia magazine. 

Born in Bari, and educated at the 
Institute of Art, the artist works primarily 
in digital illustration across both 
personal and commercial projects. His 
art is characterised by blood, tears, 
tattoos, piercing, band-aids, open 
wounds, skulls and scars. 

“My illustrations are vivid, erotic, 
subversive, part emo, part punk,” the 
Italian says. “They’re between realistic 
and surreal, as both operate in some of 
the same realms of beauty.”

1Catwoman “This portrait started as 
a series of full-body sketches on 

paper, before I decided to focus on the 
face. It’s inspired by Tim Burton’s take 
on Catwoman, with a touch of blue.”

2Sacramento Horror Film 
Festival “This art featured on the 

poster for the Sacramento Horror Film 
Festival. The commission asked me to 
combine a love of horror with a hint of 
irony. I decided to use one of my 
favourite horror characters Pinhead, and 
play with the shape of his head so that it 
represented a heart shape.”

3Damn (Iron Man) “I usually draw 
female figures, and I’ve always liked 

the colours and the LEDs in Iron Man’s 
armour. So I tried to combine the two, 
creating a portrait of Pepper but 
reflected in Iron Man’s helmet, which 
frames the scene.”

1

2 3
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David Navia
Location: US
Web: http://ifxm.ag/dnaviag
Email: davidnaviart@gmail.com
MEDIA: Photoshop, Procreate,  
After Effects, KeyShot, ZBrush,  
3ds Max, Modo

David has his sights set 
high: the Columbian artist 
aspires to work on titles set 
in their own worlds, such as 
the Harry Potter movies, 

The Fifth Element and Star Wars. He’s a 
freelance illustrator and concept artist at 
LA audiovisual outfit Pyramyth Studios, 
and comes from a traditional painting 
background. Yet he’s equally adept in 
digital mediums, which he uses primarily 
for his work in visual development for 
films and video games. 

“My biggest passion,” David says, “is 
simply creating characters, filling up as 
many sketchbooks as I can.”

1Wizard of Oz (Ride) “My favourite 
band is a Spanish folk heavy-metal 

group called Mago de Oz. I also love the 
characters that master illustrator WW 
Denslow created for L Frank Baum’s 
best-known novel. That was enough for 
me to come up with this funny scene.”

2Coffee and TV “Originally based 
on a still frame from the 1998 movie 

Practical Magic, the painting turned out 
to be a totally different image with new 
characters and story.”

3Chloë “Chloë Grace Moretz is by far 
my favourite actress, so I just wanted 

to create a proper homage to her.”

1

2

3
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Artur Sadlos
Location: Poland
Web: www.artursadlos.com
Email: artur.sadlos@gmail.com
MEDIA: Photoshop

Seasoned concept artist 
Artur works at computer 
graphics, 3D animation and 
digital special effects 
studio Platige Image. The 

Warsaw-based creative counts Ubisoft, 
Techland and GS Animation as clients, 
working on titles such as the Witcher 
series, Ryse: Son Of Rome and Call Of 
Juarez: Bound In Blood. 

Artur, versed in traditional as well as 
digital mediums, also find times to work 
on personal projects – particularly 
illustrations for book covers. “I’m 
inspired not just by modern digital art, 
movies and animation,” he says. “But 
also by the works of old masters.”

1Moeti Ancient “This is my tribute 
to the animated films of Hayao 

Miyazaki, especially Laputa: Castle in 
the Sky. I love this sense of mystery and 
ancient relics from past civilisations – 
discovering hidden temples and 
treasures, strange machines covered 
with plants and merging with 
environment. There’s a bit of an Iron 
Giant and Indiana Jones vibe as well. 
Jungle temples are my thing.”

2Hot Day “It was on a hot, summer’s 
day, and my grandfather and I went 

for a walk to our garden. This painting is 
my attempt at capturing that particular 
moment, although it’s a memory that 
remains forever in my mind.”

3Moeti Rock Formations “This is 
from a personal project called Moeti. 

It’s all about exploring a distant, alien 
world somewhere in the galaxy. This 
time I was exploring a dry, desert 
landscape with these strange, weird 
looking “rocks”. But are they really 
rocks? Or is it a life-form similar to our 
coral reef, but on land. Who knows?”

Send up to five pieces of your 
work, along with their titles, an 
explanation of your techniques, a 
photo of yourself and contact 
details. Images should be sent as 
300DPI JPEG files. 

Email: fxpose@imaginefx.com 
(maximum 1MB per image) 

Post: (CD or DVD):  
FXPosé
ImagineFX
Quay House, The Ambury
Bath 
BA1 1UA, England

All artwork is submitted on the 
basis of a non-exclusive 
worldwide licence to publish, both 
in print and electronically. 

submit your 
art to fxposé

1

2
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IMAGINEFX CRIT
“Artur is a concept 
artist as skilful  
as he is versatile. 

Hot Day is my favourite. 
Mood, light, colours, his 
grandfather rubbing sweat 
from his brow … it’s a 
really lovely, engrossing 
image. The Pole is a 
master craftsman.” 
Gary Evans,
Staff Writer

3



Copy right When is copying another artist okay? Pro artists debate 
the use of third-party imagery that goes beyond basic reference

Southwesterly Gale, St Ives by Frederick Judd Waugh: the piece Craig Mullins 
used as close reference in his painting for Blizzard (main picture).  

A huge, listing orc boat dwarfed by the 

Great Sea – waves barrelling, breaking 

over saw-toothed rocks. It’s a painting 

meticulous in detail, right down to the 

proportion of the rivets. Craig Mullins 

created the World of Warcraft piece as 

part of Blizzard’s Fine Art Project back  

in 2012, which he only recently uploaded 

to his personal website.  

An animation (http://ifxm.ag/CraigGIF) 

posted on Warosu.org shows two sections 

of Craig’s waves closely resemble those in 

the 1907 painting Southwesterly Gale, St Ives 

by American realist Frederick Judd Waugh. 

Much handwringing across message boards 

The art of imitation 
followed. Craig responded with a Facebook 

comment, saying the image was a working 

comp for a physical oil painting: “I’ve used 

photos, 3D models (mine and others) 

paintings (mine and others) in every 

combination you can think of. If I had to ask 

what method I use mostly, it would be a 

simple block model (that I make) and 

painting with that in a reference layer. But  

90 per cent of the work I’ve done is pretty 

much straight painting.     

“I’ve also talked at length about the 

difference between art and commercial art. 

I’m an illustrator and paid to make an image 

that satisfies a client. I would say every 

New wave: Craig Mullins 
referenced a painting  
by a long-dead American 
artist to create this World 
of Warcraft image. 
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How common do you think  
it is for an artist to use other 
people’s images, in techniques 
such as photobashing?
I guess it really depends on the 
industry. But in the film industry  
it mostly comes from the very quick 
turnover times asked of concept 
artists. The ability to produce 
highly realistic images within just 
two to four hours is made possible 
by using photos. There simply isn’t 
the time to paint and render 
absolutely everything.

Why do you think some 
consider this to be not proper 
art, or even deceptive?
It’s apples and oranges, really, since 
concept art isn’t an end product, 
whereas other forms are. Concept 
art is functional. We're not trying to 
make things to hang in a museum, 
or pieces with a deeper meaning. 
We’re trying to deliver a product 
and deliver it on time. We’re a 
support role and should be seen as 
such – even though we’re all artists 
and we all want to make great and 
beautiful work.

What do you see as the line that 
should not crossed, both legally 
and morally?
It depends on how the art is 
ultimately going to be used. If it’s 
internal and you have 30 minutes 
to make something that needs to 
look super-real for a presentation, 
you sometimes don’t have a choice. 
It doesn’t feel good and you don’t 
want to do it, but you’re there to 
convey an idea. That’s all. Not to 
make pretty pictures. But anything 
you want to have published or that 
you want to show to the world – 
that has to be yours, using stock 
photos and nothing else. But most 
of all, you have to be respectful. 

Industry insight

The artist on how industry time 
constraints force his hand

Titus is a video game concept 
artist. He’s working on Tom 
Clancy’s The Division for 
Ubisoft in Malmö, Sweden.

www.tituslunter.com

  Is it true, as the quote 
goes, that good artists copy 
and great artists steal? 

mystery 
setting
How frustrated fantasy 
artists got together  
to create their own 
pop-up art exhibition, 
in the myth-laden 
English town of 
Glastonbury.  
Page 23

studio 
hat-trick
American sculptor and 
polymath Tim Bruckner 
kindly shows us around 
his unusual workspace. 
And his other art 
studio. And his other 
one. Yep, three.
Page 24

readers’ 
letters
This month a reader 
sends in her dragon art, 
we clear up some 
confusion about our 
digital subscriptions, 
and talk about working 
in RGB and CMYK. 
Page 26

“There’s a difference between illustration 

and fine art. That difference is the client,” she 

explains. “As an illustrator, ultimately your 

job is to please the client.”

As creative director at sci-fi and fantasy 

book publisher Orbit Books, 

Lauren will often arrange a 

photoshoot to create the 

composition of a book cover, 

then decide who she’s going 

to commission to illustrate the final piece. 

She has a very specific goal: to reach a 

target audience. Some illustrators like these 

constraints, others don’t. Lauren says the 

process of explicitly copying parts of a 

reference doesn’t make the completed work 

any less artistic. Similarly, in commercial 

Titus 
Lunter

Orbit Books creative director Lauren Panepinto 
often sets up photoshoots to show artists exactly 
what she wants before she commissions them  
– a process used for this David Seidman cover. 

technique is totally okay – as long as what 

was done is clear. Roy Lichtenstein was 

pretty clear about his process. This was not 

the case here. Hopefully, looking at the bulk 

of my work you can see that I’m competent 

enough to have done this painting in a 

different way than I did.”

Using another artist’s work as your own 

can quickly bring you into the realms of 

either copyright infringement or plagiarism. 

The former occurs when material restricted 

by copyright is used without consent. In this 

instance, Waugh died over 70 years ago and 

so his work’s not copyrighted. It’s in the 

public domain.

Plagiarism relates to false claims of 

authorship. It’s a moral offence against the 

plagiarist’s audience. So here the question is 

not a legal but a moral one: is it true, as the 

quote goes, that good artists copy and great 

artists steal?

Creative director Lauren Panepinto 

believes there are grey areas involved. 
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concept art studios around the world, 

techniques such as photobashing using 

stock photos are common practice because 

they’re quick and cheap. 

Lauren continues: “There’s is a difference 

between artists using such methods as part 

of their process, and those using other 

people’s art and pretending all the work is 

theirs alone.” It boils down to 

acknowledgement. “You need to be 

absolutely clear you’re building on 

something. If you’re hiding that and taking 

credit for creating things you didn’t do, 

there’s a plagiarism problem,” she says.

“Craig’s mistake wasn’t that he created 

the piece the way he did. He made a mistake 

when he uploaded art and included a piece 

without explaining the methods used, or 

perhaps uploaded a piece that wasn’t meant 

to be part of his portfolio. It’s hardly grounds 

for a witch-hunt. Nor does it call into 

question any other art he makes.”

Raphael Lacoste also empathises with 

Craig and says the techniques he employed 

are nothing new. “Staring at a 

blank page is stressful. It’s 

naïve to imagine that even 

traditional masters didn’t use 

any references to start. 

Masters from the 17th and 18th centuries 

used the camera obscura to copy lines of 

composition in landscapes. Some artists, 

with maybe less experience, imagine that 

using references is cheating – I often hear 

that with my students. But it’s not the case. 

It’s no different to the classical master using 

engravings from anonymous artists – or 

even known masters – as inspiration.”

The art director and illustrator, who’s 

worked extensively for video game giants 

Ubisoft and Electronic Arts, has rough 

guidelines when using other artists’ imagery: 

“We can’t use a landscape or cityscape 

composed and designed by a concept artist 

without crediting them. This is stealing art. If 

you use the exact composition, atmosphere, 

colour and contrast of a photo, and it makes 

up more than 50 per cent of 

your final artwork, you must 

credit the photographer.”

However, John Picacio 

doesn’t agree.  “That 

postmodern thing of, ‘I’m just sampling 

other people’s stuff – I’m just gonna put 

these together…’ Sorry. Maybe I’m old 

fashioned. But that doesn’t work for me.”

John has won virtually every art award 

going, but David McKean heavily influenced 

his work as a young artist – so much so that 

he finds it difficult to look back over some of 

his earlier stuff. It gives him “the icks”. Yet he 

maintains there’s a difference between that 

– essentially homage – and lifting wholesale 

from other artists’ creations. 

“Even Giger or Moebius – visionary artists 

who changed the way people look at certain 

modes of art and opened a doorway to 

things not previously seen – you can still see 

roots in their work. Those who came before 

them. It’s there. It can’t be helped and all 

great artists know you just have to 

acknowledge these things.”

John refers to a quote by one of his 

collaborators, sci-fi writer Michael Moorcock. 

He imagines a huge stew to which the best 

creative people throughout history add.  

“Michael says that it’s fine to take away from 

the stew as long as you’re also adding 

something new to it. 

“Giger and Moebius and all great artists,” 

John concludes, “they’re always giving so 

much more than they’re taking out of the 

great creative pot of stew.” 

  Staring at a blank page is 
stressful. It’s naïve to imagine 
that traditional masters didn’t 
use any references 

Raphael Lacoste’s Asgard’s Journey. The illustrator 
says artists must credit their references.  

La Luna by John 
Picacio, taken from his 
forthcoming Loteria 
game set project. 

Reactor Awoken by 
Ubisoft artist Titus  
Lunter, who says 
short deadlines often 
require speedy 
techniques such  
as photobashing.
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Ten mythic artists irritated by the lack of 

opportunities to exhibit their work have 

joined forces for a pop-up exhibition in the 

historic English town of Glastonbury. 

The Exhibition of Mythic Arts & Crafts – 

Tales from the Dark Forest will showcase 

work from artists and artisan craftspeople, 

pieces honouring the British 

landscape, its folklore and its 

mythology. “We’re a co-

operative,” says Marc Potts, 

one of the 10 artists involved, 

“totally frustrated at the lack of gallery space 

in this country for the mythic and fantasy 

genre. So we set up a 'fluid' exhibiting group 

creating pop-up exhibitions that will 

eventually travel around the UK each year.”

The artists involved cover a wide variety 

of disciplines – from oils, acrylics and 

watercolours, to pewter work, digital art and 

even anthropomorphic taxidermy. Last year 

was the group’s successful inaugural show 

and Marc reports that attendees loved the 

chance to see fantasy art “in the flesh” and 

to buy a piece to take home for themselves. 

“People have very few opportunities to view 

this kind of work anywhere but online,” he 

says. ”Many had never even come across the 

genre before. As you can imagine, we feel 

passionate about our genre, so it’s really 

fulfilling to hear the compliments and talk to 

a new audience.”

The Exhibition of Mythic Arts & Crafts 

runs 12-13 October at Glastonbury Assembly 

Rooms, Glastonbury. To see more from Mark 

Potts visit www.marcpotts.co.uk.

Artist news, software & events
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‘Isis Fallen’, an acrylic 
piece by Marc Potts 
featured at the Glasto 
pop-up exhibition.

‘Eron’, a purely digital 
work by exhibiting 
artist Chris Down.

Glasto gallery show
Myth making A collective of mythic artists is set to 
hold an exhibition in a suitably mysterious setting

‘Queen of the May’, a 
clay and mixed media 
sculpture by Kelly  
Potts Martinez.

‘Cinderella’, a graphite piece by Alexandra Dawe 
and another example of the exhibition’s variety. 



First, Studio A was completed. If you 

sculpt then you’ll soon produce lots of 

sculpture and you need a place to put them. 

I have two display cases in Studio A.  

I remember my first day in the studio: it felt 

cavernous. Too much room. Too much 

ceiling. But then I got used to it, and then  

I needed more room. And so we took the 

decision to set up Studio B. 

Studio B is for mouldmaking, casting and 

cleaning resins. Working with silicone rubber 

and resins is a messy business that could 

account for the studio being in the state it’s 

in. I have two pressure pots: a 10-gallon 

model on the floor and a 2.5-gallon unit on 

the casting table. I use the smaller one 

constantly. The 10-gallon, although rarely 

used, is a life saver. I never use a vacuum 

chamber – it seems like a waste of time and 

money. You can’t cast with it, and a pressure 

pot will do the same job as a vacuum 

chamber: it’ll de-air the silicon rubber and 

produce better moulds with less work.

Studio C was a natural progression, in 

keeping each space function-specific. My 

paint set up is pretty basic. Ninety nine per 

cent of what I paint is brush work. I use cel 

vinyl paint, which can be purchased directly 

If you’re an artist, you spend 

more time in your studio 

than anywhere else. Even 

when you don’t have to be 

there, somehow, there you 

are! It can be a place of troubling 

frustration, anger, depression and, of 

course, great joy. 

My studio is a converted calf barn. When 

we moved to the farm it was just another 

outbuilding destined for storage. At the time 

I was working out of what would become 

our daughter’s bedroom. It was very 

cramped in there. 

Tim Bruckner
Triple aspect The American sculpture and polymath  
shows us around not one but three fascinating workspaces…

ImagineNation News
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Here’s my photo setup. To the left of the door is the album 
I did for Ray Charles’s Renaissance album. Next to this is 
Spider Jerusalem, an action figure I did for DC Direct, and 
the action figure of Ghost Rider, which I made  for Toy Biz.

Studio C This is where I do all the paint work, photography, photo clean-up and 
computer work. It’s upstairs and has good natural light all day long. Far right is 
my more literal interpretation of Duchamp’s Nude Descending a Staircase.



from Cartoon Colours. There’s a really good 

chapter on paint application  

in the book Pop Sculpture, which I  

co-authored. Any paint work is always at the 

service of the piece. You can bury a good 

piece under an overly ambitious paint 

application. Conversely, you can uplift a 

poorly sculptured piece by redirection.

These days, it's hard to imagine not 

having all these spaces.

Tim's 40-year career has seen him work on 
everything from album covers to special effects, 
but sculpture is his speciality. You can see more 
of his work at www.timbruckner.com.
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The smaller pot is in a 
green metal bowl. It’s 
filled with sand. You 
always want to try and 
cast with the floor of 
the pot level. This setup 
enables me to easily 
adjust the pot. 

Studio B Pictured here are the five most important tools in this studio, aside from my two pressure pots. The 
microwave heats the moulds, to the right of that are the drill press and band saw. In front of the window is 
the belt sander and on the far right is the room temperature vulcanisation (RTV) silicone cradle. I built the 
cradle to support the heavy drum when I’m pouring out the RTV. It’s both a time saver and a back saver!

Studio A Most of the  
2D design work takes  
place at the drafting 
table. The workstation 
to the right of it is for 
mould construction, 
clay cutting and various 
and sundry other 
processes. The yellow 
mat area is where I’ll do 
full-figure clay-roughs 
that are too big to work 
on at desk level. 

The mannequin is great for working out costume 
details. I used it a lot when working on my Christmas 
Carol Collection. You can’t have too many books – 
until you don’t have any place to put them. 



CMYK or RGB?
I’ve always wanted to become an 
illustrator, but after art school, I 
became involved in graphic design 
and the printing industry and those 
dreams were put on the back burner. 
But now I’m working on my art skills. 

Given my work background, I’m 
curious how the pros approach 
choosing a colour space to work in. I 
know that significant colour shifts 
can occur when converting from RGB 
to CMYK for printing. Do most artists 
work in RGB and chance the 
conversion? Work in RGB and convert 
themselves before submission? Work 
in CMYK from the start? And what’s 
the best way to ensure what the artist 
sees on their monitor or tablet is the 
same as what’s seen by the art director 
or publisher? 
Harry Searcy, via email

Claire replies Hello Harry, nice 
question! Artists generally work in 
RGB because it has a larger colour 
gamut compared to CMYK. Monitors 
are RGB, too, so what you see is what 
you get. Keeping your files RGB 
enables you to use all Photoshop 
filters, which you can’t do in CMYK 
mode. And RGB files are smaller in 
size, so they’re easier to manage. 

Clients might want to use a 
particular CMYK colour profile in 
their product, so it’s best to send 
them an RGB image to ensure a 
better conversion. Keeping your 
image as an RGB file will also mean 
that it’ll be ready for the web. 

Photoshop’s Proof Colors tool 
gives you a rough idea of how your 
RGB file will look before converting 
to CMYK. This demonstrates the shift 
in colour, yet still enables you to 
modify your RGB file. 

As you’ve said, everyone has 
different monitors/hardware, colour 
profiles and room lighting 
conditions, so no two images would 
look the same on different computers. 
One solution would be to calibrate 
every device in the production chain 
for visual consistency, but this would 
take a fair bit of time!

Art inferno
I’m 16 years old and I’m writing in 
to send you my digital artwork in 
the hope that I might see it printed. 
I love your magazine, I find it 
incredibly useful and it’s great to 
see so many talented artists. 

I’ve drawn for as long as I can 
remember. I love doing fantasy artwork 
and drawing predators, especially big 
cats, for their unparalleled strength and 
sinuous movements. I’ve been doing 
digital art for three years, and I started 
out on Painter 11 before moving on to 
Photoshop CS5. I’m inspired by music 
and my love of movie soundtracks, as 
well as TV series and books. My drawings 
are there to express how I feel; my artwork 
is my outlet. I enjoy it immensely and I’m 
always looking to improve.

I’ve attached some drawings for you. 
Inferno is my most recent one, and also 
took the most time. I adore drawing fire, 
and I wanted this dragon to look like a 
beast straight from hell. I tried to give his 
scales a rough texture to make him look 
ancient. My favourite part about this was 
doing the translucent skin in his jaw, 
through which the fire is glowing and his 
veins are illuminated.

Mother of Dragons is inspired by Game of 
Thrones. Daenerys Targaryen is my favourite 
character; I love and admire her sense of 
morality along with the ruthlessness she 
sometimes displays. It was also the first time 
I tried to draw lips accurately.
Lizzie Freeman, via email

Claire replies Lizzy, your email is the kind 
of email I love! I adore when readers send in 
their art and reveal what compels then to 
paint. You’ve got great potential, so keep at it.

How do you choose?
First of all, I’m a huge fan of your magazine. 
The collection of artwork and knowledge 
every month is stunning. 

I’m currently an art student studying at 
university, and I was wondering how artists 

DID YOU MISS 
ISSUE 113?  
Visit our shop at 
http://ifxm.ag/
ifxstore for 
details on this 
edition and other 
special offers, too.

are chosen to write your workshops. What’s 
the criteria? In addition, how is the cover 
artist chosen? I don’t think I’m quite there 
yet, but it’s one of my long-term goals!
Anna, via email

Claire replies That’s a tough one, Anna! 
Usually, I pick a theme for the issue and try 
to find the best artists who are working in 
that field of expertise to provide a cover or 
workshop for us. Or, I might just stumble 
across a brilliant gallery of work while 
browsing the online galleries and contact 
the artist to discuss working together. I don’t 
care if an artist is professional or amateur, I 
just look at the art and get a feel of what they 
can provide to our readers. If anybody wants 
to submit their work to me they would need 
to send a small outline of what they could 
provide –  for example, composition 
expertise or software know-how, and a link 
or attachments to a few of their images.

Why buy the issue when  
I can’t read the words?
I just downloaded an Apple app for 
ImagineFX. I went to look at the issue you 
were promoting and when I tried to zoom 
on my iPad so I could read the small print, it 
wouldn’t do so. If I can’t read about how 
something is done why would I subscribe? 
Or did I miss something?
J Wes, via email

Claire replies Hello, I think that what 
you’re looking at is the preview version. If 
you buy the issue, you’ll receive a high-res 
version that will enable you to zoom in, so 
that you can read the small print.

Computer editions
I live in the US and have been trying to buy 
single copies of ImagineFX for my iMac. 
Every time I try to buy a single issue, it sends 
me to a screen where the only option is to 
buy a yearly subscription. I can buy single 
issues for my iPad but, for some reason, I’m 
unable to buy a copy that I can read on my 
Mac. Any suggestions?
Steve Abrams, via email

Claire replies Hello Steve, if you want to 
read single issues on your computer rather 
than your iPhone or iPad, you’ll need to buy 
them from Google Play or Zinio. Apple 
Newsstand is for iOS devices only.

Inferno (top) and Mother 
of Dragons are just two 
examples of Lizzie’s 
digital fantasy art.

ImagineNation
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Our star letter writer wins a  
dA Premium Membership!
• Browse more content more quickly  
• Customise your profile page • Receive 
exclusive discounts & offers • And more!

Contact the editor, Claire Howlett, 
on claire@imaginefx.com or write 
to ImagineFX, Future Publishing, 
30 Monmouth Street, Bath,  
BA1 2BW, UK
Follow us on twitter: 
www.twitter.com/imaginefx
Tell us your thoughts on: 
www.facebook.com/imaginefx

YOUR FEEDBACK & OPINIONS

Corrado Vanelli provided plenty of priceless Painter 
advice in his cover art workshop for issue 112.

http://beta.imaginefx.com/shop


essential art  
resources

Videos, images, brushes  
and more are available  

with your digital  
editions!
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Get a digital subscription to 
ImagineFX and save money!
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Jeff Simpson’s eerie cover image 
sets the tone for this issue, as we 
reveal the secrets to painting dark, 
unsettling art with Anthony Scott 
Waters, Xavier Collette, and the 
man behind many iconic horror 
posters, Graham Humphreys.  
We also talk to Les Edwards, 
whose fantasy and horror work  
is instantly recognisable.

The Pre-Raphaelite art movement 
provides the inspiration for 
Corrado Vanelli, whose painting 
graces our cover, and Katarina 
Sokolova who reimagines Ophelia. 
Elsewhere, Donglu Yu constructs a 
city using textures, Mike Corriero 
concepts fantasy beasts, and 
Wylie Beckert translates her digital 
skills to traditional media.

Find out why so many artists, 
including John Howe, Lorland 
Chen and Brom, are attracted to 
illustrating stories that have 
passed down the centuries. We 
explore the comic art of Claire 
Wendling, Cynthia Sheppard 
brings a Greek goddess to life, and 
Tran Nguyen reinterprets the 
classic damsel in distress narrative.

On Batman’s 75th anniversary, we 
look at the dark art of Gotham’s 
infamous vigilante, with imagery 
from Jock, Frank Miller, Neal 
Adams and more, while DC 
Comics’ Ken Lashley creates our 
cover. We also explore Simone 
Bianchi’s sketchbook, draw a 
Wolverine fight scene and find out 
how a Fables cover is painted.

Issue 111 
August 2014

Issue 112 
September 2014

Issue 110 
July 2014

Issue 109 
June 2014

This month we’re helping you break into the exciting animation industry. 
Pramin Phatiphong makes a 2D character design look 3D, Mingjue Helen 
Chen designs an environment for animation, and ex-Disney artist Chris 
Oatley provides advice on how to turn pro. Elsewhere, Michael C Hayes 
paints an armoured warrior, and Brian Froud reveals his art influences.

Issue 113 
October 2014

issuesBack
Missed an issue of ImagineFX?  

Don’t panic – many of our 
previous editions are available 

for you to download today!
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We boldly go into a galaxy of 
space art, highlighting the artists 
who made their name in the genre 
and talking to the digital painters 
who were inspired by them. Our 
workshops section reveals how to 
paint an epic environment, alien 
figures and use references, while 
our Q&A section covers horror, 
skin and futuristic hair styles!

Issue 101 
November 2013

Traditional skills meet digital 
methods in Jean-Sébastien 
Rossbach’s cover art, which also 
heralds a new section in the 
magazine that’s devoted to 
bringing you the best in traditional 
fantasy art. We talk to Daren 
Bader and Keith Thompson about 
their inspirations, while Jim Pavlec 
brings a gothic creation to life.

Issue 102 
December 2013

Discover the art skills you’ll need 
to break into the competitive 
video games industry, as we 
speak to the people behind The 
Witcher 3: Wild Hunt, Star Wars: 
The Force Unleashed, Remember 
Me and Mass Effect. Traditional 
fantasy artist Tom Kidd paints a 
book cover, and Dave Kendall 
puts Manga Studio 5 to the test.

Issue 103 
Christmas 2014

This month’s artists will help 
you push your painting skills into 
untapped areas, with advice on 
creating art from smoke brushes, 
developing your artistic voice, 
plus our traditional art workshop 
on painting a frog princess! Simon 
Dominic revives an old concept, 
and we reveal the winners of this 
year’s Rising Stars contest.

Issue 104 
January 2014

We talk to the artists behind some 
of the most beautiful female 
paintings in the universe in our 
pin-up special – from a sassy 
roller-girl covergirl to amazing art 
from Adam Hughes, Serge Birault 
and Sorayama. Elsewhere, we 
delve into the world of tattoo art, 
and give advice on artist’s block 
and softening your painting style.

Issue 105 
February 2014

Celebrating the power of book 
illustration, we speak to Cory 
Godbey about his ethereal art and 
to Tony DiTerlizzi about his motion 
picture-inspiring art. Cory and 
Tony give us tutorials, too, on 
creature design and book covers, 
respectively. There’s a studio 
profile on Tor Books, and a look at 
Brian Froud’s latest work.

Issue 106 
March 2014

This issue we explore the art of 
the Seven Kingdoms with our 
Game Of Thrones special. Mélanie 
Delon paints Daenerys Targaryen 
for our cover and we talk to the 
key creatives on the show, and 
even chat with its creator George 
RR Martin about his vision for the 
stories. All this, plus even more 
great art, tips and workshops!

Issue 108 
May 2014

catch up on what you’ve missed!

By adding in beautifully detailed 
Taiwanese aboriginal costumes, 
cover artist Han-Yuan Yu has 
given his manga art a distinct 
look. Christopher Moeller paints 
comics in a traditional way, Serge 
Kolesov depicts a mermaid from a 
new perspective, and Wayne 
Reynolds tells us how he turned a 
boring art job into something fun!

Issue 107 
April 2014
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Got a question for our experts? let us
ease your art-ACHE at help@imaginefx.com

Answer
Paco replies

Those balls help an artist to 
paint the light correctly in an 
image. Sometimes it’s easy to 
forget where the light is coming 

from, especially on a large image with lots 
of elements, which requires you to zoom in 
to work. Placing one of those balls next to 
your image means you’ll always be 
reminded where the light is coming from 
– as long as you remember to refer to it, of 
course! You can also use the ball as a 
palette for picking the right colours every 
time, or even treat it as a base to start your 
painting in some cases. 

To create one of these balls, you just need 
to use a circular selection to create a circle, 
fill it with a base colour, and then add the 
lights with the Gradient tool or a brush if 
necessary. You can (and should) also add 
any secondary light source, or paint the 
light on the ball according to the material 
you’re going to paint.

Question
I’ve seen balls used in digital art video tutorials that 
show the direction of light, but what’s the point of them?
Jason Treadwell, US

Specular and diffuse

Some materials have specular reflection, like a 

mirror, while others are diffuse (a rock
, say), 

but most of them have both. It’s a good thing 

to reflect that on your reference ball.

Artist’s secret

I used the ball as a 
reference when 
painting this image, 
which makes it easier 
and quicker to depict 
the lighting.

Remember that colours 
on the image, the 
ground or in the sky will 
affect your reference 
ball to some degree.

get your 
resources

See page 6 now!
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Paco Rico Torres
Freelance illustrator Paco lives 
in Spain, and has produced  
sci-fi and fantasy art for 
several card games, 
magazines, books and  
role-playing games. 

www.pacorico.blogspot.co.uk

John Petersen
An education in biological and 
pre-medical illustration led 
US-based John to become an 
animator and designer at 
Engineering Systems, Inc. He’s 
also a freelance illustrator.

www.petersenart.com

Naiha Raza
Naiha is a self-taught digital 
artist from Pakistan. She 
works in the video games 
industry not only as an 
illustrator, but also as a 
graphic designer.

www.nraza.deviantart.com

Nick Harris
English artist Nick moved 
across to a digital canvas in 
2000 after 18 years working 
with traditional methods. He 
works mainly on children’s 
illustrations for books.

www.nickillus.com

Sara Forlenza
Sara’s a freelance illustrator 
living in northern Italy, where 
she works on book covers, 
digital card products and 
role-playing games. She’s also 
a keen PC gamer.

www.saraforlenza.deviantart.com

Mark Molnar
Freelancer Mark works as a 
concept and visual 
development artist for the 
entertainment industry and 
freelances for film, game and 
animation companies.

www.markmolnar.com
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Step-by-step:
Make use of a sphere 
when painting

 Because I’m painting a portrait where 
the base shape of the head is similar 

to a ball, I’m going to use the ball as a base 
to the head of the character. You can’t 
always do this, of course, but if the 
painting subject is appropriate then it can 
be a good way to start. I just copy the ball 
and deform it using the Transform tool.

 Next, I apply different elements to the 
base. The light and shadow indicate 

the volume of elements, so it’s important 
to get this right first time. I start to add 
additional volumes to the base following a 
simple logic: elements facing upwards will 
reflect the upper light source, while those 
facing downwards won’t.

 I introduce more detail, colour 
variations, and additional volumes and 

information, while checking the ball to see 
if everything has the correct luminosity. It’s 
easy to forget the base illumination when 
you’re caught up in the painting process. 
An image can have lots of cool detail, but if 
the lighting’s wrong, everything fails.

Question
Can you help me paint someone  
who’s sweating from being nervous?
Amanda Bolton, US

Answer
John replies

If you look at a close-up of a photo of 
a drop of sweat on someone’s face, 
you’ll see that it’s just a tiny rounded 
surface reflecting the environment, 

much like a Christmas ornament. The top half 
will generally reflect the sky or light source, and 
the bottom half reflects the ground plane and 
objects. The surfaces that come around and meet 
the skin will reflect the skin, and the sweat’s 
refractive properties will make those edges 
appear darker. Often the surface tension against 
the skin texture will cause the sweat droplets to 
take on irregular, jagged shapes, but they still 

follow those principles of reflection and 
refraction. Sometimes, if the droplet is running 
down, the reflected highlight will fade up into 
the skin colour, and the drop might also cast a 
slight shadow beneath it.

In Photoshop, start with some dark irregular 
blotches and then fill in the reflected highlights 
and ground colours, adjusting Levels and Opacity 
as required. Keep the large overall skin highlights 
on your character very glossy; the skin is wet, after 
all. It’s going to look weird at first, but it’ll come 
together once you start adding Transparency to 
the droplets. Vary the size of the drops and 
increase some of the highlights, to suggest the 
drops are running down their forehead.

Anatomy of a droplet. It’s really like any other rounded, 
reflective surface – just smaller and semi-transparent. The 
sky and ground are both reflected.

Lock the silhouette

When I’m painting a character I’ll often fill a 

base colour for the silhouette of the figure on a 

separate layer underneath the line art, and 

then lock the layer’s Transparency. Then I can 

paint with a broad brush.

Artist’s secret

The key to painting 
sweat droplets is to not 

overdo it and try to 
break up the uniformity. 

Make sure those skin 
highlights are glossy.
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Question
Can you help me paint a burn injury  
on a human character please?
Karen Spick, England

Using the Smudge tool
If you have problems depicting the texture of the 

burned skin by simply painting, then try painting 

some random brushstrokes and then distorting them 

using the Smudge tool. This will give you a valid base 

texture that you can build upon later.

You can use a textured 
brush to paint the 
texture of burnt skin. 
Some textured 
brushstrokes here and 
there can achieve a lot.

Answer
Naiha replies

Hands can be difficult to draw 
for novice artists because 
they’re complex parts of the 
human anatomy. A lot of 

professional artists tend to photograph 
references when working with the human 
body: this not only saves time but also 
helps to capture some of those awesome 
skin and joint details!

Drawing hands and arms is not, 
however, dependent on shooting reference 
images. The two most important things to 
remember are the proportions and the 
form. To help me get the proportions right, 

Question
What’s the key thing to remember  
when drawing arms and hands?
Ollie Smith, England

Answer
Paco replies

The best way to learn how to 
paint something realistically is 
to study and observe real-life 
references. So if you want to 

learn how to paint a burns victim, the first 
step is to search for photographs of burn 
injuries. Naturally, seeing such images can 
be distressing, but if you’re determined to 
paint the topic then references are key.

There are some characteristics of heat 
injuries that you should consider. The 
texture of burned skin features distinctive 
wrinkles and foldings. The worse the burns 
are, the more intense that texture will be. 
The make-up artist who designed Freddy 
Krueger’s look used the melted cheese on a 
pepperoni pizza as a reference for the 
character’s burned face. So if you have 
problems understanding the burned flesh 
texture, do the same thing: observe and try 
to paint melted cheese, then apply the 
results to your character. 

If you’re painting a face, bear in mind 
that the facial features can even melt away: 
lips become thicker and wider, noses can 
shrink in size, and if the wounds are bad 
enough then some features can disappear 
or melt together. There are some 
pigmentation changes on the skin that you 
should consider (red, yellow or dark tones, 
while black skin can become white in burnt 
areas). Finally, don’t forget that a burned 
scalp will have a significantly reduced 
amount of hair.

I usually break down the body parts into 
very simple shapes. Once this is established, 
it becomes an indispensable guide for the 
rest of my painting. 

The form, in this case, means how three-
dimensional your illustration of a hand or 
arm looks and how it would fit in a real 
environment. To understand this, it’s 
important to define a light source from the 
beginning. Once your illumination is in 
place, you can easily determine how the 
shadows will appear and be cast by 
elements in your image. From this, a form 
will naturally emerge!
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Artist’s secret

Examining photos of 
people who have burn 
wounds is the best way 
to understand the 
peculiarities of this kind 
of injury, and therefore 
go about depicting 
them realistically.

Proportion and form 
are the two crucial 
things to keep in mind
when drawing hands.

media://vod.creativegroup.futurecdn.net/P28lsAMyoQ2Ns.mp4
media://vod.creativegroup.futurecdn.net/5gBhwmcQ7439X.mp4


Question
I’d like some tips on painting the look of extreme pain 
without using reference material. Can you help?
Ryan Roddick, England

Answer
John replies

Not using reference is a 
sacrilege as an illustrator! 
I’ve taken workshops with 
some of the most legendary 

artists in the industry and they are the 
first to tell you to get some sort of 
reference, even if it’s just making faces in 
the mirror. But if you can’t, there are 
some characteristics that apply to any 
creature with human-like facial features.

When a face is contorted in pain, the 
eyes squint shut, producing wrinkles, 
and the eyebrows come up at the centre, 
wrinkling the forehead (1). The teeth are 
clenched and bared, the lips part, and 
the corners of the mouth widen and 
turn down (2). The nostrils flare into a 
snarl and the nasolabial sulcus becomes 
more pronounced and comes up and 
out (3). The head tilts forward, tucking 
in the chin and producing transverse 
wrinkles across the neck (4). Finally, the 
neck tendons bulge and tighten (5). Just 
think about the last time you stubbed 
your toe, and channel that expression 
into your character!

For this example I draw a normal, 
expressionless face, and then paint some 
key landmarks over the normal features 
to map out how some of them will 
change. Then I use those landmarks to 
construct my character’s pained 
expression. Lots of quick, high-energy 
strokes will also help convey the mood.

Use a calm-looking  
face as a starting point 
that you can refer to  
as you construct the 
new expression.

The different areas of 
the face change 
dramatically as it 
contorts in pain. 
Wrinkles become more 
pronounced and 
everything scrunches 
and stretches.

Broad brush for hair

When painting hair, avoid painting individual 

strands. Start with a broad brush and block in 

large shapes, subdividing as you go.

Step-by-step: Ensure your arms and hands look correct

 Start with the palm for the hand and 
then add fingers. Be careful where 

you depict the joints. Use the length as a 
starting point for the arm and add in some 
appropriate shapes to emulate the 
muscles. This is a crucial step, so take as 
much time as you need.

 Your form is now ready for some 
details. You can further define the 

shapes at this point and add any finishing 
touches. Remember that you can always 
go back and adjust the arm’s proportions 
or the light source if something doesn’t 
look quite right.

 Establish a light source for your new 
shape. If you’re using a reference 

image then keep the direction of the light 
in mind while painting. This will help make 
your sketch look believable. Add shadows 
and highlights and be sure not to ignore 
the secondary reflected lights.
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Question
Please help me create the effect of a magnifying glass
Amy Bloque, Poland

Step-by-step: Enlarge objects under a lens

Answer
Nick replies

Readers who wear spectacles 
will be familiar with the 
benefits of distorting lenses to 
compensate for eyesight 

deficiencies. I count myself in that large 
group. Yet folk often worry about painting 
such distortion effects, when they should 
be licking their lips at the fun you can have. 

If photographic realism is the goal, then 
good reference is always going to be the 
best way to go. But this isn’t the approach 
that I want to take with this question. 
Access to some lenses to peer through will 
definitely help, though. 

Convex lenses tend to magnify, while 
concave do the reverse. The fun begins 
when the curvature and/or lens thickness 
vary, so that objects may be magnified or 
reduced more in the centre, compared to 
the edges. It depends on the strength of the 
particular lens. Each has its own specific 
focal length that can mean objects appear 
fuzzy or sharply focused, depending on 
how far from the lens it is. These variables 
are what make things interesting. If you 
really want to go to town you can play with 
reflections on the lens surface, scratches, 
dust and imperfections. But it’s best to 
master the basics first.

 Working in ArtRage, I 
sketch out a scene that 

features several lenses 
operated by a girl naturalist, 
who’s using a head rig to 
inspect the undergrowth. I put 
her centre stage in the 
foreground so that the lenses 
aren’t too small. I also overlap 
them for more potential fun. 
Think Johnny Depp conducting 
the autopsy in Sleepy Hollow, 
without the blood.

 I rough in my garden 
scene, placing frames for 

the lenses, but avoid 
attempting distortions yet, 
apart from the large lens at the 
front of the composition. I 
know more or less what I want 
in that one already. For the rest 
I imagine that the frames have 
no glass in at all. I want to 
understand what distortion-
free objects will be behind the 
bits of glass first.

 My process tends to 
involve line-work over 

blocks of solid colour, with 
washes overlaid for tone and 
interest. I establish a light 
source and consolidate things 
a bit more, to understand how 
the light will be hitting the 
frames. They need to read 
properly, so that the lenses 
look realistic. My hand-drawn 
ellipses are far from perfect, 
but suit the style of the piece.

 Once it’s progressed more 
to set the forms, I can play 

about with the level of 
distortion. I do this on layers 
above. I darken the edges of 
some lenses with watercolour 
washes, then contrast a sharply 
focused finger with a blurry 
arm behind in the big lens. I 
bend her glasses frame seen 
through another. It’s just a case 
of playing around until you 
produce an effect you like.

I place the various 
lenses in the scene  
first, and then consider 
how the magnifying 
effects would look.

Use colour sets
ArtRage, like many other painting programs, offers the ability to save col

our sets 

per image. If you need the set for a sequence of images, why not save colours to 

the toolbox panel so that they’re easily accessi
ble with your chosen brushes?

Artist’s secret
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Answer
Sara replies

I choose to paint a goddess of 
earth and rocks, so that I have a 
recognisable human shape, but 
also an interesting contrast 

between the soft lines of a female body and 
the hardness of stone. Next, I sketch some 
of the stone irregularities that will help me 
depict a realistic surface. 

I select the colour of the base stone and 
paint light and shadows on the character’s 
anatomy. Only when I’ve defined the body 
do I start to paint the stone effect on it. 
Then I add typical stone details, such as 
grain irregularities and cracks, making sure 

Question
How do I paint a character  
made of stone? 
Jessie van Linden, Canada

that they’re consistent with the light source. 
Photo references of stone surfaces come in 
handy at this point. I also use Hard brushes 
with a rough texture. Finally, I add traces of 
moss and mud. In some areas such as the 
face, shoulders, elbows and hip I paint rock 
formations using broken lines, which 
suggests the hardness of the stone material.

Question
I have an assignment to paint 
a rotting animal. Any tips?
Jason Mandrake, US

Layering the carcass  
reveals some of its 
skeleton (1) and the 
hollow body (2). I try  
to follow the bones with 
the skin (3) to create an 
interesting silhouette.

Answer
Mark replies

I imagine a scene where a cowboy finds the cadaver 
of a giant mutated creature in the desert. I want to 
depict the carcass in a condition where most of the 
rotting phase is over, but the skin and skeleton is 

almost fully intact. The dry climate has preserved the body, so 
we can still see the overall shape of the beast.

I start by blocking in the creature’s silhouette and then 
roughly paint the composition. Then I introduce parts of the 
skeleton that’s visible through the dry skin. The next step is to 
integrate the bones and skin and also add some holes to the skin 
to show the hollow insides of the carcass. Layering is important 
here, because I don’t want to end up with a flat animal pelt. 

Finally, I add more textural details to the whole body, 
primarily using Overlay layers to preserve the painterly details 
that are already in place. I use various textured custom brushes 
in this case, but this is also the opportunity to be creative. For 
example, in some of my projects I’ve used photos of rust and 
concrete surfaces to achieve the look of an uneven rotting skin.  
I also fix the lighting and add a few more details to the focal 
point to finish the scene off, so that the image communicates 
the story perfectly.

Keep in mind the 
importance of broken and 
hard lines when painting 
cracks in the rock.

Painting the anatomy before adding the details of 
the rock helps to maintain the recognisable 
human shape of the character.
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Question
What design elements would boost the 
realism of my flying fantasy creature?
Hilary Jenkins, Scotland

Answer
Mark replies

I start by designing the creature 
in 3D using the digital sculpting 
tools in ZBrush. This software 
has the option of working in 

symmetry, which helps me create a 
balanced body shape. I want to give my 
giant flying beast wings that are similar to 
the shape of large birds, without the typical 
silhouette that’s created by feathers. 

I end up with a wing shape that’s 
somewhere between an albatross’s soaring 
and an eagle’s gliding profile. I add the 
antenna-like elements to give the creature 
extra balance, but am careful to ensure  
that they don’t affect the original silhouette 
too much.

After this sculpting stage I duplicate the 
creature, place them in a flying formation 
and do some quick render passes directly 
from ZBrush. I then import the renders into 

Photoshop and composite the images 
together. Now I paint over the creatures to 
better integrate them into my background. 
Because I already have the basic lighting 
information from the 3D renders, I only use 
quick washes of colours on Overlay, Soft 
Light and Color layers to add colour and 
more definition to my creatures. I also 
decide to change and erase back the 
silhouette of the wings slightly, to make 
them look thinner and fragile. This is one 
step that would have taken a long time 
using the original 3D model. 

After deciding on a base colour I finish 
the creatures by applying some patterns to 
the wings and some additional 
complementary colours to the body and 
antennas. I bring the image together by 
adjusting the contrast and brightness, and 
fixing the hues using the Color Balance tool.

Always indicate scale
Using additional familiar animals in your creature designs could help you indicate scale. In this image I’ve used multiple flock of birds following the giant creatures – almost like small 
fishes following whales in the ocean. 

Artist’s secret

Question
How do I paint a thin material 
that shows the body’s outline?
Andrew Laird, England

Answer
Nick replies

Sometimes when a bright light is behind someone, 
that’s just what happens. Fabric appears translucent 
and the person’s form appears as a silhouette 
through it. It all depends on the type of fabric and 

the pose. For example, a heavy brocade is unlikely to generate 
this effect, where chiffon or silk can. 

The silhouette cast also depends upon the tailoring of the 
outfit. Extra folds of material such as in a full skirt or long robe 
can affect the lighting where areas overlap. The best way to 
tackle such an effect would be to set up good reference, but here 
I’m working without one. 

I pick a pose with a clear silhouette. Clear silhouettes are a 
great general rule of thumb for illustration or animation in most 
cases. Using ArtRage I sketch out and block in a leggy and 
unclothed female character in a basic pose. Whichever way your 
character is facing, you need backlighting for the effect, so I 
shade her accordingly. Now I add a dress; I decide on a flared 
skirt being blown by the wind. I block in the shape on a layer 
above, with reduced opacity. Remember to follow the contours 
of the body. When I’ve established the folds I can gauge where 
fabric doubles up and where it doesn’t. Those areas will be 
darker and/or throw more shadows.

I pick a pose that 
offers a clear 

anatomical shape, 
with no crossed 

limbs. That could 
cause confusing 

shadows and isn’t 
what I want here.

The key to painting 
giant flying creatures  
is ensuring that their 

proportions feel correct 
and look familiar. 
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When adding the motion blur 
effect to the grenade, be careful 
not to overdo it otherwise it may 

become unrecognisable.

Step-by-step: Depict a bouncing object

 After I’ve sketched the picture and put 
all the elements in it, I decide on the 

position of the grenade. I begin to trace 
my motion lines to suggest its trajectory. I 
also keep in mind the perspective in the 
image; the motion lines will start close to 

each other 
and 
gradually 
move apart 
to contain 
the shape of 
the grenade.

 During the colour stage I give the 
grenade prominence by placing a 

lighter colour behind it. Then I paint the 
area between the motion lines with a light 
grey to emphasise the movement, and 
focus on where the grenade bounces on 

the rubble. 
There I use 
circular 
kinetics lines 
to suggest 
its sudden 
impact.

 I try to make my grenade stand out 
from the background even more by 

adding some smoke. I paint the wake of 
my grenade so that it’ll be brighter and 
visible in the area where it bounces off the 
rubble. I paint the details of the grenade 

without 
overdoing it, 
because I’m 
going to 
add a 
motion  
blur effect.

Looking at the line art 
makes it easy to see 
how I can use motion 
lines to describe the 
grenade’s movement.

Question
Can you help me paint something 
ricocheting off a solid surface?
Dhanu Chopra, US

Answer
Sara replies

I decide to draw a crazy 
anarchist throwing a grenade. I 
put the character on the left so 
that I have enough space to 

depict the bomb flying through the air. 
Let’s assume that it bounces off some of the 
debris on the floor and flies towards the 
viewer. This gives me the opportunity to 
illustrate a semi-realistic scene, and use the 
comic drawing technique of motion lines. 
These enable me to suggest the movement 
of an object by drawing its trail, and present 
the character’s actions in space and time. 
This informs how I proceed with the image.

I try to capture the motion of the grenade 
as it leaves the hand of the character and 
sails through the air. To make this work I 
add a neutral colour to the grenade’s wake. 
After painting the grenade’s details I add a 
blur effect to match the motions lines that 
trail in the grenade’s wake.

next month: mirror reflections | blood-splattered walls | rim lighting 
 masks | advice on values | camp fire scene | character in the rain and more!

Remember the image structure

Representing an action that involves space and time means I have to 

build the image so that it’s easy to predic
t the grenade’s movement, 

without adding too much detail in the wake of it.

Artist’s secret
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Tony Foti explains the key 
features of the world’s most 
popular digital art program

nce upon a time, being an illustrator required 
paints, brushes, tools, canvases, ventilated 
space, free time and enough of all of those 
things to be sufficiently trained in a complex 

skill set. Much in the same way home digital recording has 
changed the face of entertainment for the YouTube 
generation, Photoshop has brought all the tools of a 
professional artist to anyone who can get their hands on it.  

I still remember opening up CS2 for the first time, 
drawing carefully with a mouse and feeling generally 
overwhelmed by the menus. It was a slow process that  
this article should help make more straightforward and 
enjoyable. If you’re a newcomer to Photoshop, you’ll find  
the following pages an indispensable guide to getting  
started and on your way to painting like the pros…

Country: US
Bio: Tony is a freelance 
illustrator who regularly
contributes to Fantasy 
Flight Games‚ Star 
Wars and Lord of the 
Rings lines, as well as 
numerous other books, 
games and magazines.
www.tonyfotiart.com

Tony Foti

The Tools window
Our first and most frequented stop is the Tools window, which opens by default attached 
to the left side of the screen. If not, just go to the Window drop-down menu at the top of 
the screen (this list enables you to turn any window on or off) and click Tools. Selecting a 
Tool icon will change the mode your cursor is in: Brush, Eraser, Shapes, Selections and so 
on. Right-click any of the icons to reveal extra options, click the double triangles at the top 
for two rows, and you can drag the bar off the frame if you prefer it to be free-floating.

Blending Modes
The Blending Modes menu can be found in the Layers window 
above where it says Lock (by default, the mode will be Normal). Try 
creating a new layer above an image, painting over it, and then 
scroll through the options in the drop-down menu. Each selection 
will blend the top and bottom layers together in a different kind of 
way. Darken, for instance, lets only the pixels in the top layer that 
are darker than those in the bottom layers stay visible.

Add textures
There are several options in the Blending 
Modes menu for adding texture. Explore 
Overlay, Hard Light, and Soft Light, which 
give precedence to the lightest and darkest 
pixels in the blending layer, leaving most of 
the middle values translucent. Try dragging 
a photo with a texture into your file, place it 
over the layer you want to add texture to, 
and switch the Blending Mode to Overlay. 
You can then erase away at the layer to 
leave texture only where you want it.

Layer Masks
Layer Masks are a way of controlling 
translucency that’s more nuanced 
than simply adjusting the Opacity of 
an entire layer (which you can do 
with the Opacity slider in the Layers 
window). Clicking the white 
rectangle with a circle in the Layers 
window creates a mask on the 
selected layer. Painting with dark 
pixels will make that section of the 
layer translucent, while painting with 
white will make it opaque again.

photoshop 

guide

starting out
A solid grasp of Photoshop’s basic windows and 
modes is essential before beginning any painting

Click here to 
activate maskNovember 201438
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photoshop quick fixes
Selection tools
Photoshop offers several ways for you to 
select parts of an image, all of which can be 
found in the Tools window. The Rectangular 
and Elliptical Marquee tools are on the top 
left: just right-click the icon to reveal every 
option. Once a tool is selected, dragging the 
cursor in an area will create a – surprise! –
rectangular or elliptical selection. Now you 
can only paint or erase in that particular 
place. The Lasso tool and its extra options 
can select more specific areas. Polygonal 
Lasso gives you control over the borders by 
creating connecting points, while the 
Magnetic Lasso attaches itself to whatever 
shaped edges are closest as you drag the 
cursor around the canvas.

Free Transform
The Free Transform option can be 
accessed by right-clicking the 
canvas while using any selection 
tool. If you use it while an area is 
selected, only that area will be 
manipulated. If you don’t have 
anything selected, the whole layer is 
affected. Once in Free Transform 
mode, right-clicking again will bring 
up a new menu. Scale changes size 
throughout (click the linked chain 
icon at the top to keep the height 
and width relative), Skew (along with 
Distort and Perspective, but in 
different ways) will lengthen or 
shorten the edges of a selection, and 
Warp will bulge and constrain areas 
as you move the border frame.

Select layer

Pull tabs

Click your selection tool again 
and apply a transformation

Right-click 
anywhere on 
the canvas

1 2

43
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Clipping Masks
When painting an object on a transparent layer, try creating a new 
one above it, right-clicking the layer and selecting Create Clipping 
Mask. Now when you paint, brush strokes will only show up where 
there are pixels in the layer below. So if part of the lower layer is 
clear, your brushes won’t work there on the upper one. This is helpful 
when you want to try out some new colours in an area you’ve 
already painted, because turning off the layer visibility enables you 
to flip back and forth between the new and original image.

Using text
The Text icon is that capital T in the lower half of the Tools Window, and right-clicking it 
enables you to change the orientation. The Properties bar at the top of the screen gives 
you size, shape, justification and font options so you can customise your text. Any fonts 
installed on your computer are accessible in Photoshop, although having too many can 
slow down the program (which is also a downside to having too many brushes). Text can 
be altered with the Free Transform process mentioned previously (right-click the layer and 
rasterize it first) and clicking the warped T over a curved line (in the Properties bar once 
again) will open up some useful preset warping options.

History states
One of the most magical aspects of painting in Photoshop is the History feature. Click 
Window>History in the top menu bar to open up a descending timeline of your past 
actions. Every time you paint a line, erase a smudge, make a selection, or do pretty much 
anything, the History window makes a note of it. Clicking the image at the top of the 
window will take you all the way back to the file’s original state when you opened it (this is 
blank if it’s new), while checking a box to the left of any history state will save it so you can 
go back whenever you need to. This is helpful when you’re happy with how a painting is 
developing, but want to experiment without fear of ruining anything.

Shape tools
That single grey rectangle with the white outline in the lower third 
of the Tools window is the Rectangular Shape Tool, and right-
clicking it will reveal the additional Ellipse, Rounded Rectangle, 
Polygonal, Line and Custom shape tools. Dragging the cursor with 
one of these selected will create the specified shape, and holding 
down Shift as you drag will keep all the edges equal in length. With 
a shape created, you can select a Fill colour (this fills in the whole 
shape) or Stroke (this creates a line over the border) using the 
Properties bar at the top of the screen.
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1 The layers system
Right up there with the History function in my Most 
Useful Features of Photoshop for Artists list is the 
whole concept of layers. In the same way that 
traditional animators will use several sheets of acetate 
in a single shot, painting different parts of your picture 
on different layers enables them to be edited separately 
while still being viewable as a whole.

3 Locking layers
Sometimes when painting, I’ll need to add a gradient to 
an area without changing its edges, and that’s when 
Layer Locking comes in handy. By clicking the small 
chequerboard icon in the Layers window, any 
translucent areas will be unaffected by the tools, 
remaining clear. You can freely brush without changing 
the all-important silhouette of what you’re painting.

5 Adjust the Opacity
Another useful function of layers is the ability to control 
their transparency. Up in the right corner of the Layers 
window is a drop-down slider labelled Opacity, which 
enables you do just that. This comes in handy for a 
variety of effects, such as creating sheer clothing, 
smoke and light beams.

2 Creating layers
In most default viewing modes, the Layers window will 
be visible and either attached to the right side of the 
screen or floating around somewhere. You can use 
Window>Layers to toggle it on and off. New documents 
will just have a background layer, but clicking the drop-
down menu at the top right will give you a range of 
options, such as Create, Duplicate and Merge.

4 Grouping
Complex assignments can lead to Photoshop files with 
over 100 layers, and when that happens you want to 
stay organised. Holding down Ctrl or Cmd enables you 
to click and highlight multiple layers at once. Then go to 
New Group From Layers in the drop-down menu. 
You’re then asked to name the group. Now those layers 
will move together and be editable as a group by 
highlighting the group folder instead of the individual 
layer for whatever painting action you’re using.

6 Backup saves
I like to create multiple save files for each image, in case 
one becomes corrupted or if I make some huge mistake 
and save before realising it. This way I always have 
several versions that are, at most, only a few hours less 
developed than what I was just working on. When this 
happens, I’ll often open an older save file, delete the 
offending layer, and drag my replacement from the old 
file (or a completely different illustration) over into the 
Layers window in my most recent iteration.

Top 5  
mistakes
Art is all about learning from 
missteps, but here are some 
mistakes to avoid altogether

The Language of Layers
It may take time, but learning to use Photoshop’s layer system 
is the key to unlocking the software’s versatility

Drag to another 
Photoshop file

New brush strokes 
won’t break 
established edges 
while layer is locked

November 2014 41

Don’t put every little thing on 
different layers: it can slow down 
the process and the program. Try 
and be more efficient…

1

…but make sure you avoid 
merging everything into one layer 
until you’re fairly certain there are 
no more revisions. Moving an 
object or character is a lot easier 
when it’s on its own layer.

2

Which layer was it that had the 
magic ring highlights? Was it 
406? Or 309 copy12? Seriously, 
name your files sensibly and avoid 
interrupting your painting flow.

3

An extended painting session can 
slow down Photoshop. It’s all 
down to its virtual memory usage. 
So save your work, restart the 
program to free up this memory 
and take a quick screen break.

4

Working on projects with a high 
resolution or excessive layers can 
also slow the program down, 
which will change the way some 
tools such as Smudge perform. If 
you need the tool to run more 
smoothly, save as a new file and 
reduce resolution temporarily.

5
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1 Brush options
Once you’ve selected the Brush icon from the toolbar, 
right-clicking anywhere on the canvas will bring up a 
small menu with shape and size options. Size is pretty 
straightforward, with a slider on the top right. Each of 
the strange shapes located in the white boxes below 
are alternate tip shapes, enabling you to create all kinds 
of different marks.

3 Brush modes
When the Brush Tool is selected, there’ll be an options 
bar at the top of the screen with Mode and Opacity 
drop-downs menus. These both work the same way 
that their Layers window counterparts do, and the 
Mode settings are exactly the same for both (Lighten, 
Darken, Overlay and so on). Instead of controlling a 
whole layer, though, they’re just applying those settings 
to your individual brushstrokes.

5 Create your own brush
Photoshop comes with an impressive assortment of 
brush options, but when something more specific is 
needed you can create your own custom ones. Open a 
new document, and then draw your desired tip shape. 
Go to Edit>Define Brush Preset… from the top menu 
and it’ll add the new brush tip to your assortment, 
shaping it from the black and leaving transparent any 
white parts of the canvas.

2 Alter your brush edges 
Some tips, like the basic Round brush you start with, 
can also have the hardness of their edges adjusted. 
Accessing the slider labelled Hardness and moving it to 
the right will make for more distinct, hard-edged brush 
strokes, while moving it to the far left will create a soft 
airbrush effect.

4 Tip settings
The brush is the tool you’ll be using most often as an 
illustrator or concept artist, so take the time to get to 
know its features. Go to Window>Brush to open the 
Brush Window, where you’ll see a list of options such as 
Shape Dynamics (pressure on your drawing tool of 
choice dictates brush size), Dual Brush (use two 
brushes at once), Color Dynamics (use multiple colours 
at once) and Scattering (turns brush strokes into a 
scattering of marks in the shape of the brush tip).

6 Loading custom brushes
The internet is full of custom brushes available for 
download. I have some Nagel brushes that have served 
me well over the years. You’ll most likely be 
downloading the files in .Abr format, which you can 
then move to the Adobe Photoshop CS>Presets> 
Brushes folder on your hard drive. Open the Brush 
Preset window and click the drop-down menu option to 
bring up the Load Brushes option. Navigate to the file, 
double-click it and the new tip will appear in your menu.

Select the  
Brush tool

Top 5  
Shortcuts
Learn these essential 
shortcuts and streamline 
your creative process

Beginning With Brushes
Get to know the Photoshop’s default 
brushes, then start adding your own
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The Ctrl+C, Ctrl+V, and Ctrl+X (PC)
or Cmd+C, Cmd+V and Cmd+X 
(Mac) commands are copy, paste 
and cut, respectively. They’re handy 
when you need to feature repeating 
shapes in your art.

The Eye dropper is a handy tool 
that replaces your brush’s 
foreground colour with whatever 
hue you click. You can easily access 
it while using the Brush tool by 
holding down Alt.

If you make a mistake, press Ctrl+Z 
(PC) or Cmd+Z (Mac) to take you 
back an action. Soon, you’ll be 
searching your mind for the Undo 
button while drawing in a 
sketchbook, talking to friends online 
and staring at sky-high bar bills.

When working on two sides of a 
selected area, press Ctrl+Alt+Shift 
(PC) or Cmd+Alt+Shift (Mac) to 
invert it, to include everything but 
your previously highlighted space.

If you’re moving around several 
objects, holding Ctrl or Cmd while 
using the Selection tool will make 
the selected area movable.

1

2

3

4

5
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1 Blur tool
This tool is located about halfway down the Tool 
window. Right-clicking it will reveal the Smudge (a hand 
with index finger out) and Sharpen (an isosceles 
triangle) tools. With one of these selected, you have the 
ability to evenly soften edges, smudge pixels around 
and increase edge contrast, respectively.

3 Filter gallery
Opening the Filter Gallery will bring up six categories of 
Filter, all of which transform the desired image or layer 
in some way. The preview window will show how each 
setting affects the image, so just click around and see 
what tickles your pickle.

2 Filters
In addition to those three tools, you’ll find an array of 
options in the Filter drop-down menu at the top. There 
are far too many for me to cover completely, so I’ll just 
introduce you to some of my favourites…

4 Blur types
Gaussian and Motion Blur can both be found under the 
Blur submenu. Gaussian is a smooth, noise-reducing 
blur option that softens either the entire canvas or a 
selected area. The Motion option will smear the layer or 
selection at one specific angle. To adjust the angle, 
either rotate the line that’s bisecting the circle in the 
window or simply type numbers into the Angle box. 
Adjusting the Distance slider at the bottom will change 
the intensity of the blur.

5 Maximum and Minimum
Two other tools I use on a regular basis are Maximum 
and Minimum, and they can be found in the Other sub-
menu at the bottom of the list. Simply put, Maximum 
will reduce the size of your shapes and lines, while 
Minimum will increase it. Say you’ve just drawn some 
clouds in the background of a sketch, but feel the line is 
so heavy that they’re getting too much attention. By 
going to Filter>Other>Maximum, you can make all of 
the lines on that layer thinner.

Top 5  
quick fixes
In this fast-paced medium 
mistakes are made, but 
there’s always a quick fix…   

tweak your marks
Some tools make marks, but these Photoshop options transform 
the marks you’ve made, often with surprising results
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By default, Photoshop’s history 
feature retains only your 20 last 
steps, but if you go to Edit> 
Preferences>Performance, there’s a 
box marked History States where 
you can alter this number. 

1

You can save your art as different 
files at different points in the 
process, which enables you to go 
back and grab an earlier version if 
you’re not happy with the direction 
it’s going in.

2

Since you’re going to be using 
multiple save files, not to mention 
collecting reference and texture 
material, I recommend creating 
organised folders for all of your art.

3

Not all menu options come with a 
shortcut, so go to Edit>Keyboard 
Shortcuts, select the set and type, 
and then select the command, 
option or tool you want to shortcut.

4

Save time when regularly doing a 
sequence of painting steps by 
recording them. Go to the Actions 
panel>New Action>Record, 
complete the action, press Stop 
Recording and give it a shortcut.

5
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Creative 
Cloud
With Adobe’s online 
subscription service comes 
many new possibilities 

Adobe’s new Creative Cloud service 
has some great new features. The 
Generator function enables you to 
add a file extension name to a layer, 
and the image file produced will be 
automatically updated every time 
you edit the layer.

1

The new Colour Import feature 
makes it possible to directly grab 
swatches from HTML, CSS or SVG 
files, for those times when you need 
to key one image to another.

2

Photoshop CC’s expanded Smart 
Object support now means that  
you can add Blur and Warp  
effects to Smart Objects without 
simplifying the information from 
the original image.

3

1 Adjustments
One essential facet of the Photoshop experience is the 
Image>Adjustments menu. All of the options in here 
make it possible to adjust your layers or selections in 
different ways, and like with the Filter menu I’ll be going 
over the ones I use most.

3 Color Balance
Color Balance, as you may have guessed, works in a 
similar way but with chroma. Select the tonal range you 
want to work with from the bottom of the window and 
adjust the sliders to tweak the hues. If you want to cool 
down your shadows, warm your highlights or just make 
something more green, then it’s worth trying out.

2 Levels
The Levels option enables you to control the contrast in 
your image with five sliding cursors. The top three 
under Input Levels adjust the intensity of your dark 
values (the black, left cursor), middle values (grey 
middle cursor), and highlights (white left cursor), while 
the bottom sliders will limit the amount of dark and 
light in your layer or selection, moving everything 
towards middle values.

4 Hue and Saturation
The Hue/Saturation tool offers something a bit in 
between the last two. Using the Hue slider will change 
all the colours at once. The Saturation bar adjusts the 
intensity of your colours, with the left side leaving only 
a black and white image and the right creating a 
psychedelic experience. The Lightness slider will raise 
and lower all the values. Often while adjusting the 
values in an area the saturation becomes less 
appealing, so using all three bars together is key.

5 Combining layers
Creating a copy of whatever layer you’re adjusting will 
enable you to compare your changes. You can also 
erase away whichever is on the higher layer to reveal 
the one below, so that the parts of the adjustment that 
aren’t working as well can be removed. Merge layers 
when you’re finished to keep things organised. 

Image Adjustments
You’ve created your painting. These functions can now help 
you to edit the colours, values and shapes in your image

Erase the 
adjustment 
layer here
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issue 115 UK on sale Friday 10 October 2014

Build a spaceship 
Elite: Dangerous artist 
Josh Atack uses 
Photoshop to paint  
a spaceship. Are you 
ready for blast off?

Concept art tips 
What makes a great 
concept artist? Donglu 
Yu reveals the skills 
you need to create 
brilliant art.

Retro game art 
Evoke the look and 
feel of 80s video game 
art, with Remko 
Troost as your mullet-
wearing guide.

Bungie’s Destiny 
Jesse van Dijk give us 
exclusive insight into 
his concept and 
character art from the 
last city on earth. 

How to concept  
and create perfect 
game characters 

The art of 
video games

Also
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Motiga’s Vinod Rams and 

Devon Cady-Lee share their 

game art creation secrets!



profile

Creeper
“Artists have dedicated a ton of their work to glorifying the 

pain and longing of failed relationships and unrequited love. I felt like 
making something to highlight the absurdity of our desires, especially 
when viewed on a truly cosmic scale. Next to the infinity of everything, 

sometimes I feel more like a creepy horny puppet  
caricature than anything else.”

Miles Johnston
Country: UK

English artist Miles is a 
largely self-taught 
illustrator who recently 
moved to Sweden to study 
at an atelier. Having 

finished his studies, he now works as a 
freelancer and also runs the Dirty 
Sponge podcast, in which he hosts 
unscripted interviews with his 
favourite sci-fi and fantasy artists.
http://ifxm.ag/miles-j

The English illustrat
or opens up his sketc

hbook to share
 

his love of vis
ual metaphor and creative com

position
Miles Johnston

No title  
“I liked the way this looks in person. The graphite is shiny 
and the red pen is a lot more matte. As I moved it around  

in the light it reminded me of old shiny  
Pokémon cards.”
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“The whole thing is one 
giant, seamless swarm 
of growth emerging out 
of the planet we inhabit”

Growth 
“This is intended as a visual 

metaphor of the way biological life 
transforms over time. From organism 

to organism and species to species, the 
whole thing is one giant, several-billion-

years long, seamless swarm of 
growth emerging out of the 

planet we inhabit.”
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Sketchbook Miles Johnston
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learn traditional art skills! Get inspired to paint using oils, watercolours,  
pencils and more with our special edition devoted to traditional art techniques 

buy://com.futurenet.imaginefxmagazine.IFZ17
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get your 
resources

See page 6 now!

52	 Draw and paint 	
a female face
Charlie Bowater uses 
Photoshop to render a 
beautiful female face with 
subtle, otherworldly features.

56	 Composition: 
myths and methods
James Gurney explains why 
there’s much more to 
composition than forcing 
elements into a grid.

62	 Paint an exotic 
market scene
Nikolai Lockertsen pushes 
the possibilities of iPad art, 
using Procreate’s colour 
options and high-def detail.

67	 How to set up 
3D models
Being smart about the way 
you set up 3D models in 
SketchUp is essential for 
success, says Mark Roosien.

68	 Texture tips in 
Painter 2015
Don Seegmiller shows you 
different ways to create and 
apply textures, to achieve 
fantastic results in Painter.

72	 Sculpt the 
perfect portrait
Digital artist Te Hu mixes 
digital watercolours to 
uncover a portrait among 
abstract shapes and colours.

This issue:

Advice from the world’s best artists

Workshops assets 	
are available…

Download each workshop’s WIPS, final image and 
brushes by turning to page 6. And if you see the video 

workshop badge, you can watch the artist in action, too.
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Colour 
variations
Whenever I start with a 
black and white sketch I 
nearly always throw on a 
colour wash in Overlay. 
It’s a really quick way of 
seeing roughly what your 
colour choices are going 
to look like. Because it’s 
such a quick method, it’s 
easy to try out different 
colour palettes and see 
which works best if you  
aren’t 100 per cent sure. 

draw and paint  
a female face
Charlie Bowater shows you how to render a beautiful 
female face with subtle otherworldly features

ver since I was a kid I’ve loved 
painting faces. No matter 
what kind of character it is,  
I always find myself drawn 

first to the face. I find the many shapes, 
features and expressions endlessly 
fascinating, so naturally I’m very happy to 
offer you a workshop on painting them! 

I’ll be talking you through the various 
steps of painting a beautiful female 

portrait, and then look in some depth at 
how to give my character certain features 
that make her appear slightly alien or 
otherworldly. Nothing too drastic – just 
subtle differences that hint at this idea. 
She won’t resemble an extra from Jabba 
the Hutt’s palace, that’s for sure!

I’ll be explaining my steps from start to 
finish, including rough sketches through 
to the initial washes of colour, not to 

Charlie 
Bowater
Country: England

Born in 1988, 
Charlie was 
raised on 90s 
cartoons and 
Disney films. 

She has always drawn for 
her own pleasure and 
now works at Atomhawk 
as a concept artist.
http://ifxm.ag/cbowater

mention painting skin, textures, colour 
choices and adding the final details. 

You can approach this workshop at any 
level really, and you can go as detailed as 
you like. I think my own style sits 
somewhere between stylised and realistic: 
I love using textures on stylised 
characters. It’s not my intention to make 
the character look too realistic, it’s just to 
end up with a nice-looking portrait! 

E

1 A basic sketch
To get started, I sketch out a few rough ideas all centring 

on the theme of a beautiful, slightly otherworldly female 
portrait. I’m keeping things simple and just using a few values 
(mid-to-light greys) and some slightly darker grey line work to 
sketch in the basic features. I’m not too concerned with any 
serious detail at this point; I’m more interested in getting down 
her pose, facial features and expression.

2 A wash of colour
Now that I have a finished sketch that’s ready to go to 

colour, I want to lay down a hint of colour without adding any 
detail (and to see if it looks good). The best way to do this is to 
add a wash of colour using Overlay. So, on a new layer (set to 
Overlay) above the sketch, I take a large brush and lay down 
some initial base colours. I avoid being too intricate, and just 
think of these as the starting point for the colour.
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Workshops

get your 
resources

See page 6 now!
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4 Order of layers
As I begin rendering the character I tend to add a new 

layer when I start painting a new section. Generally, I’ll add a 
couple of layers. Then, once I’m happy with that section of work, 
I’ll flatten everything together. I repeat this process throughout 
the painting. I try not to have too many layers going on at once, 
but you can have as many as you’re comfortable using.

7 Importance of colour choices
One tip for painting skin is to think about colour choices. 

A base tone is your starting point. When building up the colour 
by adding shadows and highlights, remember to change the tone 
as well. Avoid choosing a shade of the colour you started with 
– change the colour also. Subtle pink/orange in warmer areas 
and a bit of blue/purple in the shadows makes a big difference.

6 Bringing out the form
With a chalky brush, my main focus here is to bring out 

the form of the face. So far it’s mostly been line work and a wash 
of colour, but now I want to focus on structure and shape. Using 
darker and warmer (slightly more red or orange) tones, I paint in 
some subtle shadows under her nose, in her eye sockets, under 
her chin and so on, to start emphasising the form.

5 Rendering and brush types
The main focus of this painting is the character’s face. 

Because it’s a close up, you’re going to see a fair bit of detail. For 
the majority of the painting I’m using a chalky, slightly textured 
brush. I love painting skin but try to avoid using airbrushes if I 
can. If overused, they give the skin a plastic appearance, whereas 
a slightly textured brush gives a much more natural look.

3 Keep in mind the character’s origins
With the sketch and colour palette chosen, it’s time to start actually rendering the 

portrait. My main focus when originally sketching the character was on her pose and features, 
but one very important aspect to the character is that she should be otherworldly, almost alien 
but in a very subtle way. That’s something I’ll be keeping at the forefront of my mind as I move 
forward with the colour process.

8 A little eye definition
The face is the first part of a character that I’m drawn to – 

the eyes in particular. I want to start adding some detail to them 
to give the painting some focus. I’m using a warm plum-purple 
colour to add some deeper shadows to the sockets of the eyes 
and directly underneath them. I’m varying between regular 
layers and a bit of Overlay to give some depth to the shadows.

resources

photoshop

Skin Pores

When drawing faces, 
I get a lot of use out of 
this very simple, yet 
effective soft chalky 
custom brush.  

A great skin texture 
brush for recreating 
pores. Just a few dabs of 
this gives skin a really 
lovely finish.   

custom brush: 
subPaint

Brush size

[ and ] (PC & Mac) 

This is my most used

shortcut and the quickest

 way to alter your  

brush size.
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Don’t be afraid 
to experiment
The beauty of painting 
digitally is the ability to 
undo! I’m sure there are 
plenty of purists out 
there, but personally I’m 
not one of them. Make 
the most of the medium: 
if there’s something you 
want to try out or change 
then just add a new layer 
and experiment. Don’t 
be afraid to make drastic 
changes if you think it 
could improve the piece. 

10 A pop of colour
I mentioned that when painting skin, it’s better to vary the 

colour choices. This is one of the times that an airbrush can be 
helpful painting skin without making it look muddy. To add a 
warm flush of colour, I take a soft airbrush, set my layer to 
Overlay or Color and add some pink/apricot to the cheeks, nose 
and lips. I keep the Opacity low for a subtle pop of colour.

14 The final touches
All the hard work is done by now and it’s just a case of 

finessing my character and adding the final details. I’m applying 
a bit more skin texture with a skin pore brush. I don’t like to go 
crazy with a specific texture brush, but a little here and there 
adds a nice touch. I also add a few bright embers to tie in the 
bright pink in her eyes. 

9 Defining the eye’s structure
Now I want to paint the structure of the eye and iris itself. 

Here I’m taking the opportunity to focus on some otherworldly 
features and make her eyes a cold, icy blue with a shot of pink 
around the middle. I want her to appear mostly human but just 
have a few, subtle features that make her appear different. I like 
the idea of adding a bright colour to her eyes.

13 Bounce lights
Now for the finishing touches. I’m introducing bounce 

lights from the background on to the character, a desaturated 
blue on to her nose and lips, and some stronger light accents on 
the fibre optic strands. I’m painting these in a bright blue (I add 
an even lighter shade in Overlay to help it pop) and then a more 
desaturated blue around these as they bounce on to skin.

11 Painting the lips
As with the rest of the painting, the lips are a gradual 

process of starting with a base tone and building up the shadows 
and highlights. I start with a fairly bright pink tone because I 
want her lip colour to stand out. Then I add a deeper pink, almost 
purple to the farthest corner of her mouth where the shadows are 
strongest. I think about the form and where the shadows will fall.

12 A smattering of freckles
I regularly paint freckles on characters. I think they’re beautiful and even if they’re only 

very subtle, they add a lovely texture and finish to the skin. I’m adding a smattering of freckles 
with my regular brush, but you can also use a Scatter brush. I personally like a mixture of 
both to help things look natural. I’m also adding some subtle blue freckles to tie in with her 
eyes and the otherworldly theme.

Moving the 
canvas

Shift (PC & Mac)
Hold down Shift 
when zoomed to 

move around  
the canvas.
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he key to composing an 
effective picture is figuring 
out the best way to express 
your main idea in visual 

terms. That idea could be a dramatic clash 
of characters, an emotion tied to an 
environment, or a mood created by a 
story. I like to begin a painting by 
clarifying the idea and then deciding 
which pictorial tools best convey it. 

The problem with most compositional 
theory is that the thinking is backwards. 
Instead of starting with the central idea, 
many art teachers dwell on shoehorning 
the picture into some rigid, preconceived 
geometry. Some focus on a set of 
dogmatic notions about how the eyes 
move around a picture. Others focus on 
abstract design for its own sake, aiming 
for rhythm, flow, balance or harmony. 

But painting is more than designing 
bathroom tiles, presenting food on a plate 
or arranging flowers in a vase. What’s the 
use of a pleasing, balanced arrangement if 
your story idea demands a design that's 
off-balance or arrhythmic? Painting is 
like any other art form: emotion and 
story should come first and they alone 
should drive the aesthetic choices.

In this workshop, I’ll start by roasting a 
couple of sacred cows and then I’ll offer 
some practical tips. Who's hungry?

T

Composition: 
Myths and 
Methods
James Gurney explains why composition 
isn’t about forcing elements into a grid

Artist insight
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illustrator of 
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wrote the 

bestselling books 
Imaginative Realism and 
Color and Light, both of 
which grew out of his 
popular daily art blog 
GurneyJourney.   
www.jamesgurney.com
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1 The Golden Ratio is a myth
Almost every composition book these days talks about the 
Golden Ratio or the Golden Rectangle, but it turns out that 
even the textbook examples, such as the Parthenon and the 
human figure, don’t conform to those ratios any more than 
they do to other mathematical relations, such as pi or 
Vitruvian relations of whole numbers. No rectangle or grid 
stands out from the others as ‘golden’. If a certain 
proportion gives us a warm feeling, it's because we've 
trained ourselves to appreciate it. For a complete discussion 
of this topic, see my five-part blog series, ‘Mythbusting the 

Golden Mean’ at www.gurneyjourney.blogspot.co.uk.
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4 Do lots of thumbnails
With each rough sketch, try to see the 
subject in elemental terms. Look for what 
Golden Age illustrator Harvey Dunn called 
the “epic in the incident.” With a visually 
complex scene with lots of figures, like a 
crowded throne room, it’s especially 
important to think about the essential idea. 
In this case, I want to convey regal power. 
I remember the feeling I had when I met 
Ted Turner one-on-one in his big office 
building, and I try to channel that memory.

3 You’ve got to feel something first
Art transmits emotion. The best design is the one that communicates the most 
powerful experience. If you want the viewer to feel something, you have to feel 
it first. That feeling will transmit to the viewer like a rubber ball bouncing off a 
wall. The harder you throw it, the harder it'll bounce. Likewise, the more you feel 
the idea, the more the viewer will, too. As Howard Pyle recommended, project 
yourself into the picture. Leap through the frame and live inside the picture.

2 Don’t worry about controlling the eye
The composition doesn't control the eye. The eye doesn't flow along contours, 
and it doesn’t move in ovals or spirals as many theorists have claimed. Eye 
tracking scanpath studies show that the viewer’s eyes leap from one point of 
interest to another in rapid succession, about three times per second. Viewers 
gravitate to faces or figures – or cleavage – wherever you place them in the 
composition. Viewers look at pictures in individual ways, and it depends on how 
their minds have been primed by such things as titles or captions.
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6 Think about the camera angle
My main characters are in the foreground, and the exotic but diminutive 
emperor is high up, perched on a Tree-of-Life throne. I visualise the whole 
sequence in my mind and then pick this camera angle. The eye level is equal to 
the height of the throne platform, a little more than a metre high, well below a 
normal human standing height, which makes the throne seem more impressive.

5 Choose the supreme 
moment in an imagined scene
Unlike a film director, we have to choose a 
single moment out of a continuous flow of 
action in which to set our scene. What’s 
the best moment to choose? Usually it’s 
the one with the greatest suspense, such 
as a fateful encounter or a moment when 
something is about to happen. If there’s a 
main character, he or she should be faced 
with a decision, or a do-or-die moment. In 
this case, it’s a meeting with the emperor.

7 Simplify extraneous details
I work transparently, building opaques gradually. 
I suppress contrasts in the throne area to keep it from 
becoming too busy. I also allow the yellowish colours to 
be dominant, with a few blues and reds as contrast. I 
eliminate greenish colours. I regularly check against the 
thumbnails to see if I’m keeping to that original idea.

 I visualise the sequence 
and pick this angle – the eye 
level equal to the height of 
the throne platform 
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10 Eliminate the inessential
From the earliest stages, all the way through the execution of 
the painting, try to delete or conceal whatever doesn’t add to 
the central idea. In the hatchling scene, I limit the colours to 
yellow ochre and a dull slate blue, leaving out greens, reds 
and pinks. Because I’m designing the painting for a double-
page spread, I allow space for the gutter and for a type area 
on the left. The whole composition includes a wider shot of 
the nest, with shell fragments and mud caked on the eggs.

9 Push extremes
Whatever forces you unleash in your painting should 
be exaggerated in any way you can. In this painting of 
a hatching Triceratops, I keep redesigning the picture 
to bring the viewpoint closer to the baby emerging into 
the light. It is the dramatic emergence into the world of 
a new life finally escaping confinement. I push the 
contrast of light and shadow, lightening the light areas 
and deepening and grouping the darks in shadow.

8 Create secondary readings
Here’s the finished painting. The boldest contrasts and 
brightest colours are in the main characters on the 
right. Everything else is a second reading. In the 
context of this story, I want the throne area to be 
mysterious, lost in a golden aura. There are lots of 
subordinate figures, but I don’t want any of them to 
attract too much attention.
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14 Vary the composition
If you’re doing a sequential work, such as storyboarding or 
scene planning for comics or film, vary the composition from 
one sequence to another. Stiff, formal compositions take on 
even more power before or after dynamic ones. In these 
storyboard panels, I think as much about what goes on 
between scenes as what goes on in a single composition. 

13 Make the colour suit the 
emotion that defines the scene
The core idea of the painting should determine the 
colour scheme. A sombre, dramatic mood calls for 
sombre, dramatic lighting and colour. I could have 
painted the hatching scene in sweet pastel colours and 
bright morning light, but I imagine it more as an urgent 
moment of crisis, where life hangs in the balance. 
So I stage the scene at night, as if dazzled by the 
intrusion of a photographer's flash. By contrast, the 
Parasaurolophus painting is colourful and cheerful 
as the young dinosaurs explore their world.

11 Add photorealistic  
focus to the focal point
Composition is not just about 2D 
considerations; it’s also about the  
Z dimension of depth and focus. Even 
though I’m painting a scene that could 
never be photographed, I try to compose 
the scene with a photographer’s sensibility. 
I use shallow focus to evoke the impression 
of wildlife photography, since this painting 
is to be published in a magazine that’s 
mostly illustrated with wildlife photos. The 
background is dark and cool and way out 
of focus, and the crushed plants and the 
egg in the foreground are also blurred.

12 Create contrasts
This painting shows an adult Parasaurolophus grazing amid water lilies, while 
several juveniles hunt insects nearby. Modelling the behaviour on that of living 
birds, I imagine the scene as a crèche of young dinosaurs sticking close to the 
adult for safety. There are many kinds of contrasts in this painting: warm versus 
cool colours, and soft versus hard textures. I'm also conscious of creating a tight 
cluster of the faces of the little hatchlings around the tiny insect, while keeping 
big, empty, blurry, uncluttered spaces in the upper areas.

 Composition is not just 
about 2D considerations; it’s 
also about the Z dimension 
of depth and focus – the 
photographer’s sensibility 
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Paint an exotic 
market scene
Nikolai Lockertsen pushes the possibilities of iPad art using 
Procreate’s beefed-up colour options and high-def detail
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ainting on the commute to 
work is something I enjoy. A 
few years ago, I painted with 

watercolour on the one-hour 
morning bus ride. I managed to balance a 
small booklamp, a cup of water, paint 
and a book in one hand, and painted 
with the other. The urge to have some 
digital device that could match what I did 
in Photoshop was strong. 

Then I bought an iPad. Previously, I 
had tried painting on my iPhone with the 
Brushes app, and although it wasn’t a 
hopeless cause, it was just too small. In 

contrast, the iPad was a perfect size and  
I could paint for 10 hours per charge. I got 
hooked! In the first couple of years I 
painted with the Brushes app. I liked it a 
lot and you could extract high-resolution 
images and video of the painting process. 
But the app had its limitations.

Then Procreate was mentioned in an 
online art thread, and when I tried it I was 
surprised at how good the brush engine 
was. It felt like Photoshop and I fell for it 
right away. Initially, Procreate also had 
some limitations: it lacked high-
resolution canvases, Selection and 

Transform tools and a lot of the 
adjustments options available today, but 
it was still the best painting app for iPad 
on the market. I’ve been a 100 per cent 
Procreate man ever since. And now the 
tool is, in many respects, better than even 
Photoshop. I have a 24-inch Wacom 
Cintique screen at the studio where  
I work, but I only use it for reference. I 
actually paint on the iPad in Procreate. 
This combination is so good now that I 
would say the only limiting factor lies 
with the artist’s skill level, rather than 
these superb digital tools.

p
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Painting a soft 
selection
You can paint a selection 
however you want. Just 
paint with a colour (I 
often use a bright green) 
on a separate layer. Then 
use the Selection tool to 
produce sharp outlines, 
or Gaussian Blur to make 
it soft. When you’re 
finished, just slide the 
layer to the left and 
choose Select. This will 
make a selection of the 
layer’s content. Then 
turn the green layer off 
and select the layer you 
want to apply the 
selection to. 

4 Base colour
I stop sketching as soon as I’ve got enough to start adding 

colour. It’s still very rough, but this is more a painting than an 
illustration, so I want to introduce colour as early as possible.  
I create a new layer using the + in the Layer menu. Holding my 
finger on the layer lifts it up, enabling me to move it underneath 
my sketch layer. Then I rough in colour with a big brush.

2 Favourite brush
I almost always start on a medium dark background. This 

gives me the freedom to use both darker and brighter values. My 
favourite custom brush is called Rull, inspired by the roller 
brushes used to paint living room walls. I use it to work on the 
majority of painting elements. I’m using the Wacom Intuos 
Creative Stylus – the best pressure-sensitive pen I’ve tried.

6 Separating the elements
I pinch the sketch and colour layer together to merge 

them. I create a new layer and fill it with the background colour, 
then merge it with the painting layer, making it solid without 
any transparency. Now to place the fleeing food and salesman’s 
tentacles onto a separate layer. I tap the Selection tool and draw 
around each element, using + and - buttons to edit the selection.

5 Finishing the rough paint
When I’m happy with the rough colour layer, I alpha-lock the sketch-layer by sliding the 

layer to the right. This locks the sketch, so I can only paint inside the existing paint in this 
layer. With my big Rull brush, I rough in colour in the sketch until I’m happy with the palette 
and feel of the image. The foundation for the rest of the painting is done, and it’s only taken 
me around 20 minutes.

3 Sketch stage
I try to sketch quickly and playfully. I remain zoomed out 

for as long as possible so I can see the whole canvas, which helps 
me get the composition and balance right early on. I often flip 
the canvas horizontally to get a fresh view on my image, using 
the option under Canvas in the settings menu. I define the main 
character shapes: the salesman and the creature trying to escape.

1 Starting the image
I want to paint an alien market stall, inspired by the 

fishmarkets in Asia. I open Procreate on my iPad and tap the + in 
the top-right corner to create a new canvas. I select Custom and 
choose 4,096x2304px, which is over four times HD resolution, 
but the same aspect. In the Layer menu I tap Background and 
pick a semi-dark blue/green in the brand new Color Wheel tool.

Procreate

It reminds me of a 
regular roller brush that 
you paint your interior 
walls with. My favourite!

custom brush: 
Rull
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7 Pushing the palette
To darken the outer areas like a vignette, I create a new 

layer and set it to Soft light mode. Then I choose a dark blue and 
drag it from the Color palette onto the canvas. This activates a 
new flood-fill tool that darkens the image. I erase the centre with 
a soft airbrush and adjust layer Opacity. Creating an Add layer 
and using a saturated soft brush creates a nice glow in lit areas.

8 Finding the right colours
I go overboard with a range of Adjustment layers and then rein them in using the Layer 

Opacity setting. The results are really easy to gauge when you can adjust a setting with just a 
single finger swipe. I like to minimise the number of layers I use, and will regularly merge 
them into one layer, except for any elements that I’ve separated out. I start zooming in and 
play around with a lot of colour variations and detail within the different creatures and 
elements in the painting.

9 Bigger colour ball
Procreate’s new Color Wheel is really easy to play around 

with. You can scale up the central ball of the wheel with a two-
finger pinch. This gives you even more accuracy when colour 
picking. You can revert to the original wheel in Settings. I pick 
most colours in painting by holding my finger in one spot.

In depth Painting in Procreate
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Highest  
image quality
When sharing artwork 
from Procreate, send it 
directly from Procreate 
to iTunes, Dropbox or 
email. To do this in 
Procreate Gallery, slide 
your image left and press 
Share or do it from inside 
the painting project. 
Then choose how you 
want to share. Don’t save 
it to Photos and then 
email it as an attachment 
or copy-paste to email 
from Photos – it might 
lower the image quality 
and sometimes even the 
resolution. If in doubt, 
use the .png file format. 

14 Final adjustments
I use a Soft brush to erase blue that’s furthest away from 

the light source before I adjust the blue layer’s Opacity. Again, it’s 
all about going overboard and then pulling back. I use a range of 
brushes to add particles, textures and so on, to give it a final 
polish. I also sharpen it by about 30 per cent and use the Curves 
tool to see if colour, contrast and brightness can be improved. 

13 The new flood-fill
I want to make the cold light behind the vendor even colder. So I slide two fingers to 

the right on the paint layer (it turns purple, which indicates it’s a reference layer). Then I use 
the new Recolor tool in a new layer that I set to Color mode. Each time I use it, I can choose 
the colour it should flood-fill to and how much it should bleed out, and repeat it for all the 
areas I want to adjust.

11 Defining the background first
In this painting and in many of my other works, I tend to build up visual interest in the 

environment before jumping in and detailing the main characters. I like to explore a bit more 
of the world they live in, but I also like to give them a background that makes them stand out 
as subjects and gives them a clear silhouette. At this point I tend to play around with different 
brushes, so that I can achieve plenty of variation in the textures and surfaces.

12 Apply motion blur
Having worked with film half my life, real-life camera 

visuals have influenced how I create my art. I love recreating 
optical effects such as focus and motion blur in my paintings. 
Here, I want some movement in the little dude running away 
and also on the salesman’s tentacles. So I use the Smudge tool 
and rub slightly with a smaller brush in the direction of the blur.

10 Crisp detail
The Selection tool is great for creating crisp details. I use a 

big brush to craft the structure of the piece, but with a selection 
active I don’t have to worry about covering too much of my 
painting. I like to keep things playful and loose! I also flip 
horizontally often until the painting is done. It’s also important 
to zoom right out, to check that your painting is easy to read.
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Looking for  
the right angle

Being smart about the way you set up your 3D models in SketchUp 
can be essential for success, as Mark Roosien demonstrates here…

1 Place your core 
components together

The entire city scene comprises only five 
components: two apartment blocks, two 
small flying vehicles and one larger 
aircraft. I place them together, away from 
the main scene, which gives me easy 
access to all of them. The aircraft was 
previously created in a separate SketchUp 
file. I open the old file, select the aircraft 
and press Ctrl+C. Then I press Ctrl+V in 
the new file to import the selected model.

2 Construct a city
I build up the city scene simply by duplicating and resizing the two blocky 

components. It’s easiest to set up the scene when you’re directly above your work, so  
I reorient the camera so that I’m looking down at the ground plane. I use normal 
perspective and forced perspective as I see fit. Here, I use forced perspective for one  
of the banking aircraft.

3 Set up the scene
I reorient the camera to find the most attractive angle, then 

select Window>Scene and click the Plus icon to save that angle. Once 
I’m happy with the result, I export the model as a jpeg and use this as a 
base layer for a 2D digital painting. Alternatively, I could just continue 
modelling in SketchUp and create a more detailed 3D scene! 

be able to easily set up scenes with only  
a few of them. 

Components can also be reused in 
SketchUp model files that you’ve 
previously created to save time. To 
demonstrate this, I’ll use a quick setup for 
a city scene, which could be used as a base 
layer for a 2D digital painting. The city 
scene serves as a backdrop for a simple 
futuristic craft flying through the air.

s I’ve shown in previous 
articles, using components in 
SketchUp (check out the free 
version of the program, 

SketchUp Make, at www.sketchup.com) 
can be a quick and practical way of 
creating objects. Now I’ll take things a bit 
further. By carefully considering which 
elements in a model should be separate 
components and which should not, you’ll 

How to set up  
3D models

In this article, I use the Select tool (A), the 
Scale tool (B), the Move tool (C) and the 
Rotate tool (D) to place and resize all 
components in the scene. To ensure the 
aircraft looks like it’s banking, I select the 
component with the Move tool (a blue box 
with red crosshairs appears) and click one of 
the crosshairs. I move your mouse while 
holding the left button to rotate the aircraft. 
You can also rotate components by using 
the Rotate tool. Just select any surface on a 
component (in this example I select the 
right-hand fuselage) and move the mouse. 
You can also use the (red or black) circular 
aid to rotate a specific number of degrees.

SketchUp
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Mark Roosien
Country: Netherlands

Mark is a 
self-taught 
artist who 
jumped from 
traditional 

media to Sketchup seven 
years ago. He specializes 
in nuts ‘n’ bolts sci-fi art.   
http://ifm.ag/mroosien
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Mirror your 
paint strokes
Switch Mirror Painting on
whenever you paint an 
object that has bilateral 
symmetry. It’ll make this 
kind of work extremely 
simple and can be used 
with any brush. Those 
brushes that have a more 
random feel, such as 
Variable Splatter, will still 
have some randomness 
when used to Mirror 
Paint and each side 
won’t be identical. 

texture tips  
in painter 2015
Don Seegmiller shows you the different ways to create and apply 
textures to achieve fantastic results in the latest version of Painter

ith the recent release of Painter 
2015 from Corel, the premier 
digital painting tool once 
again raises the bar of what 

can be achieved using a single digital 
painting program. While the new Particle 
Brushes are the ‘wow’ feature of this 
release, lots of work has gone into 
improving the workflow, speed, and 
stability of the program overall.

One of the strengths of Painter has 
always been the ease with which you can 

use textures while painting. The program 
enables you to create and apply textures 
in a number of ways, including papers, 
patterns, brushes, weaves, and now the 
new Particle brushes. The artist is limited 
only by their imagination and ingenuity.

In this workshop, I’ll be creating a 
painting of an alien and his – ahem– 
flying saucers. I start with a basic sketch 
before painting a black and white image. 
I’ll then apply colour to this monochrome 
image, and then enhance the painting 

Don Seegmiller
Country: US

Don is a 
successful 
artist, author 
and instructor. 
He currently

coordinates the 
Illustration Program at 
Utah Valley University 
in Orem, Utah.   
www.seegmillerart.com

with some texture. Some finishing 
touches will bring everything together.  

It’ll help matters if you have a fair grasp 
of Painter’s basics. You should also know 
how layers work, and how the Composite 
Methods can be used to modify the 
appearance of those layers. It will also be 
useful – though not essential – if you 
understand how to create brushes, 
patterns and paper textures. 

So let’s get started and see what’s 
possible with Painter 2015. 

W

1 Creating the alien sketch
I draw my initial sketch with pencil and paper, scan it into 

Painter and continue to refine the drawing using a custom brush 
(Dons Brush) and the Eraser tool. Dons Brush is a simple and 
fast brush that I use extensively. I use the Mirror Painting feature 
to refine the alien’s head, and draw objects with bilateral 
symmetry. I can move the mirror axis anywhere around the 
canvas and even change its angle. It’s a great time-saving tool, 
and well worth becoming acquainted with.

2 Adding monochrome values
Now that the basic drawing is complete, I need to add 

value to eliminate the white canvas. I create a new layer, change 
its Composite Method to Multiply and begin laying in different 
values of grey over my drawing using a combination of the 
Airbrush and Dons Brush. I decide where the light source in the 
painting is located and concentrate on the general feel.
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4 Introduce details
I’m ready to start refining the character by adding detail. 

I paint the brain wrinkles and continue to develop the rest of the 
painting, using my combination of Dons Brush, Digital Airbrush 
and Grainy Water. I create a small custom palette of the brushes 
I’m using by holding Shift and dragging the brushes icon from 
the Brush Selector on to the Canvas area.

7 Finished colour painting
With my colour scheme established I collapse the grey and 

coloured layers together, then finish the coloured section. I make 
changes to the alien’s sleeves while adding the buttons, button 
holes and gold trim on the tea pot and saucers. I add a shadow 
on the floor with a new Multiply layer and an elliptical selection, 
filling it with a darker background colour and blurring the result. 

6 Establishing the colour scheme
I create a new layer over each element: the alien, teapot 

and background. I change the Composite Method of the new 
layers to Color as I prepare to decide on a colour scheme and add 
it to the painting. I like complementary and split complementary 
colour harmonies, and decide to use one based on green, yellow 
and violet. I add these colours by painting on each colour layer.

5 Finishing the grey painting
I continue to work with the grey image until I feel it’s complete. I decide to make the 

alien’s body longer and change his costume. Indeed, I’ll continue to make small tweaks as the 
painting progresses, when I feel they’re needed. The teapot and alien are still on their own 
layers, enabling me to easily tackle the background.

3 Adjusting the composition and size
My alien is crowding the edges of the painting, so I drop 

all the layers on to the canvas, select and cut out the alien and 
teapot, and paste them into new layers. I move these around to 
find a better composition – a smaller alien and a larger teapot 
– and offset them so they’re not so central. I tweak the values and 
blend the edges with Grainy Water in the Blenders category.

8 Applying skin texture to the alien
I create and fill a new image with blobby spots using 

Effects>Esoterica>Blobs. I repeat this four times with different 
colours, copy the blobs, paste them over the alien’s face, select 
the white areas and delete them. I duplicate the layer twice and 
place them over the tentacles, change the Composite Method to 
Multiply and reduce the Opacity so that the blobs are just visible. 

Iterative Save

Ctrl+Alt+S (PC)

Cmd+Opt+S (Mac)

This creates an updated

file version and adds a 

version number to  

the filename.

resources

Painter

Candle Smoke

It’s my general sketching 
and painting brush.

One of the new Particle 
brushes in Painter 2015.

custom brush: 
Dons Brush
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Put together a 
custom palette
It’s easy to create a 
custom palette for 
projects. For objects 
such as Brushes, Paper 
textures, Patterns, Brush 
looks and Nozzles, all 
you do is hold Shift and 
drag the item’s icon to
the canvas area. A new
palette is created with
the item’s icon. To add
items, hold Shift and 
drag the icon to the new 
palette. To add a menu 
item choose Window>
Custom Palette>Add 
Command. Select your
palette and pick a 
command from the menu 
bar or palette menu. 

10 Give the vest a weave texture
I open the Weaves Libraries and Weaves panel under 

Window>Media. I create a new layer that covers the entire vest 
and fill it with one of the default Weaves. I duplicate the layer, 
changing the first to Multiply, then create a selection around the 
vest, invert the selection and clear the extra weave. Then I adjust 
the Opacity of each and collapse the layer on to the alien layer.

14 Final texture tweaks
To add steam to the tea and solar flare-like textures to the light, I create a new layer, 

change the Composite Method to Screen and paint the steam using the Candle Smoke 2 
particle brush. I duplicate the layer and add blur to the bottom copy, then combine them.  
I create three layers and set the Composite Method to Screen. On the bottom layer I use the 
Casting the Net brush to add texture over the light; on the second, I use Atomic Particle to 
create the spiral. On the third, I use Crack Thing to add smaller textures close to the light. 

9 More skin texture
I use a custom paper texture on the skin and Variable 

Chalk from the Chalks and Crayons brush category. I select the 
Cell01 paper texture, create two layers, set one to Multiply, the 
other to Screen. I adjust the texture size and paint the Multiply 
layer. I invert the paper texture and paint the Screen layer.  
I reduce the Opacity of both until they’re just visible on the skin.

13 Adding overall textures to the image
I like to layer additional texture over the whole image as a 

finishing step. I use textures that are created using traditional 
materials, such as watercolour, scanned at 300dpi. I’m looking 
for interesting effects. I layer each texture individually, adjust its 
colour, change its Composite Method, and adjust the opacities. 
Finally, I erase the areas where I don’t want the patterns to show.

11 Create the floor
From the Patterns panel I select Capture Pattern. I create a 

new layer and fill it with the checked pattern. Using Edit>Free 
Transform I place the pattern in the correct perspective behind 
the alien layer, then create a new layer, fill it with background 
colour, and carefully erase the lower portion of the layer, which 
leaves a foggy feel in the distance. Finally, I collapse both layers.

12 Finishing the background
Using a large Digital Airbrush I darken the background at 

the top. I want a light behind the alien so I create a new layer, 
change the Composite Method to Screen, fill the selection with a 
dark orange and blur the results. I duplicate the layer twice, Free 
Transform both layers and add more blur. I arrange them like a 
glowing light. On a final Screen layer I splatter Airbrush spots .

Alter Brush Size
Ctrl+Alt (PC)

Cmd+Alt (Mac)
Use this keyboard 
combination to 

interactively resize 
any brush.

In depth Painter 2015
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sculpting the  
perfect portrait
Digital artist Te Hu shows you how to mix digital watercolours to uncover 
the portrait in an open canvas of abstract shapes and colours

atercolour as a traditional 
media offers artists a 
particularly expressive 
power. With practice and 

dedication, it’s possible to mix colour and 
water in such a way as to create fantastic, 
translucent works. In the digital realm, 
Painter 11 is rightly popular for its 
watercolour-based tools that do a great 
job of simulating these advantages of 
real-life paint. Thanks to the digital 
canvas, we can also be more experimental 

when mixing materials and textures, 
which are easy to adjust as we go. 

Art, to me, is an ongoing process of 
adventure and exploration. I don’t like to 
line-draw sketches first and then paint 
over them. I think painting should be fun 
from start to finish. I’ll often just let my 
emotions guide the flow of colours and 
attempt to find interesting shapes and 
patterns along the way to create 
something more defined. I tend to liken it 
to sculpture, where it’s possible to take a 

Te Hu
Country: US

Te works
as a technical
artist for 
Visceral 
Games at EA. 

Originally from China, he 
studied at Carnegie 
Mellon University’s 
Entertainment 
Technology Center in 
Pittsburgh. His 3D art is
to be shown at the 
forthcoming Lucas 
Museum of Narrative Art.   
www.huteford.com

piece of clay or marble and find the 
masterpiece inside. 

In this workshop, I’m going to show 
you how I use digital watercolour tools to 
extract a subject from abstract shapes and 
colours and eventually end up with a fully 
developed portrait. Using some of the 
methods and techniques you’ll see in the 
following pages, you too will be ready to 
experiment with the basic tools in Painter 
and ArtRage to craft creatures, portraits, 
and even entire scenes. 

W

1 Create a background
Usually when I begin a digital piece in Painter, I’ll 

concentrate on the basics. I prefer to just lay some colour on the 
canvas. You can use a favourite photo or a texture to give you the 
basic feel and tone of the image. For example, here I’ve just used 
a flow of colours that bleed into each other, and in such a way,  
I have a basic colour palette to choose from.

2 Find a great reference
Once I’ve decided what I want to paint, I usually find an 

image reference online or from my personal photos. I try to 
analyse the basic shape of the image, especially the feeling it 
evokes. Bear in mind that a work of art is an emotive response to 
the world around you; keep looking for a reference until you find 
one that resonates emotionally and inspires you.
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Using digital 
watercolours
Having experimented 
with the digital 
watercolours in Painter, 
I find the most important 
tip is to set the paper 
correctly – it has a huge 
impact on how the 
watercolour dries out. 
Furthermore, use large
brushes first and learn to
control the speed of how
you draw; it generates 
interesting effects. 

4 Mark the ‘landmark’
Now I transform abstract colour blocks into something 

more tangible. When I paint a portrait, I try to work in a 
traditional way. Try to imitate what you’d do in real watercolour. 
Paint the eye socket, nose, lips and rough position of the hand. 
These elements don’t need to be precise, but try to use darker or 
lighter values to indicate their position and shape.

7 Secondary blocking
The second most interesting element is the hair. Here I’ll 

use a smaller-sized brush to paint the more intricate shapes. I’ll 
also use layers to paint the strands. That’s the good thing about 
digital watercolouring: you can always tune the intensity of each 
shape and pattern, and once you’re happy you just collapse them 
into the main layer.

6 Start with the eye
When the blocking stage is finished, you can start on the 

second layer and begin to lay down the most important features. 
You can start with the nose, hand, lips or even ears, but I usually 
start with the eye. As a Disney artist once told me, the eye is a 
character’s most important feature. I’ll refine the features to a 
certain degree until I’ve achieved the look and feel I’m after.

5 Refine the overall tone
Now I have an idea of what the image is going to look like. 

I’ll usually step back and have a cup of tea or something and 
then return to see where I’m at. I’ll create a layer on top of 
everything to indicate what needs to be done and what needs to 
improve. I’d like this image to be warmer and more feminine, so 
I jump into Photoshop to adjust the colour balance.

3 Block out big blobs
Once you’ve found the right reference, the fun can begin. 

Using the colour palette I set up, I just start blobbing out shapes 
on the canvas. Just be like a child and go for it – do as you like. In 
this case, I’ve made a large area of darker value, because 
watercolours don’t include white.

8 Hands, hands, hands
Hands are important, especially for portrait pieces. They 

can express a character’s emotions in subtle ways. However, 
hands can be tricky to get right, so I’ll use the Pencil tool to draw 
out the shape of the hand, and then refine it using layers of 
different watercolour strokes.

Painter

Oil Pastel

This creates a random 
edge and works as the 
most similar brush in real 
life. It’ll gradually dry out.

This is the smooth detail 
brush I used to shape  
the details.

Standard brushes: 
Wet Flowmap 
Fringe
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Step back and 
review your art
After two or three hours 
of painting, I usually step 
back from the piece and 
take a break. Then I’ll
return to the work to see
what stage it is at. Often,
I’ll create a layer on top
of everything and
indicate what needs to
be done and what needs
to improve. Incorporating 
such a stage should give 
you a better end result. 

10 Details
At this point, I usually switch my brush to Oil Pastel and 

Wet Pencil to get into the details and start refining the subject of 
the painting. I keep my focus on how the textures and fabrics 
look, and work on emphasising them.

14 Final adjustments
To complete my mermaid I use the Liquefy function to 

adjust the shape and detail, and then I tweak the colour balance. 
Finally, I import the image into ArtRage to apply some subtle oil 
paint highlights. And now my painting is finished… or perhaps  
I should just say, “Fin!” 

9 Brightness and darkness
Now is a good time to step back and review the painting. 

I’ll use this moment to figure out the general grey value of the 
painting and work out where it needs to be darker and lighter, so 
that the figure pops out of the canvas.

13 Add a creature
I always think a portrait painting should have elements 

that insinuate a greater narrative in the scene and enliven the 
context. For this piece, I insert a little deep sea creature into the 
environment to accompany the mermaid.

11 Environment is important
Even though it’s a portrait, I want to keep the surrounding 

environment as abstract and painterly as possible. To do this, I’ll 
layer out a texture I like in Photoshop, to give a subtle sense of 
variation and a vague indication of where the character is.

12 Add a ‘fantasy’ element
Since I want to create a mermaid, I use fish-like textures 

and other shapes associated with marine life to enhance the 
fantasy aspects of the character, such as the eye and the scaly 
parts on her hands and shoulder.

Lift off! 
Concept artist 
Josh Atack 
creates a starship.

Dust to dust 
Thomas Scholes 
reveals concept 
art from Ashen.

80s-tastic! 
Paint retro game 
art with Remko 
Troost’s help.

Concept tips 
Donglu Yu passes 
on her advice for 
working in games.

Figures of fun 
Vinod Rams and 
Devon Cady-Lee 
paint game art.

Next month
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The latest digital art resources are put 
to the test by the ImagineFX team…

SOFTWARE & hardware
78 Bamboo Stylus Duo 2 
78 Affinity Designer
training
79 Creature Sculpting in 
ZBrush Vol 1
Books
80 Sci-Fi & Fantasy Oil 
Painting Techniques, & more

Price £30 (free for owners of ArtRage 4)  Company Ambient Design  Web www.artrage.com  Contact contact@artrage.com

Resources such as 
Stencils and Presets 

can be duplicated 
and moved between 

groups (image shown  
by Nick Harris). 

ArtRage 4.5
Artrageous Fortune One of our favourite pieces 
of digital painting software has just got a little bit better

rtRage has long given us 
some lovely tools and 
effects at an affordable 
price. The latest update 

(v4.5) isn't a huge advance, but it's a 
reminder that Ambient Design is 
headed in the right direction. Also, it's 
a free update for owners of version 4 
– proof that the developer is more 
interested in people than profits.

Like Corel's Painter, the modus 
operandi here is creating a realistic 
painting experience. The tools on offer 
don't quite have the depth of Painter's, 
but there are more than enough and 

A

 There are enough tools to keep all  
but the most demanding of digital 
artists satisfied 

Tilt your stylus when using the pencil tool and you will 
notice how it directly affects the lines you draw. 

The thickness of grid 
lines self-adjusts as 
the size changes.

Collect layers, presets, 
colour samples and 
stencils in the Toolbox.

they feel tactile and lifelike. An oil brush 
starts out fully loaded with ink, but 
quickly thins out and becomes more 
transparent. The watercolour brush, 
meanwhile, delivers a pale line with 
darker edges – just like the real thing.

The way that different paints interact 
is impressive, too. A palette knife can 
be smeared over the virtually damp 
canvas to blur and distort your 
creations, for example. One impressive 
addition in the latest version of Painter 
is the addition of more psychedelic 
Flame Painter-style brushes. ArtRage 
doesn't include quite as many options, 

and the results aren't quite as 
convincing. There's still a lot to love 
here, though. With its chunky menus 
and large tool and colour selection 
areas, ArtRage looks like a tablet app, 
and as a result it's far more accessible 
and child-friendly than Corel's 
increasingly bustling Painter. It also 
includes stylus tilt detection – a feature 
that's only just been added to Painter.

ArtRage feels like it's where Painter 
was a few years ago, before it became 
crowded with features. This is no bad 
thing. The price is low, and we love the 
fact that Ambient Design has chosen 
to drop the Pro version so it can 
concentrate on making the best 
possible version of ArtRage. It retains 
an elegant simplicity that Painter can’t 
match, and for the price it’s a very 
competent digital painting program.

Reviews
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Features
n 64-bit support

n Larger canvases 

n Canvas grids

n Live pencil tilt 

n Interface updates 

n Paint Symmetry 

n Scraps and Views  

n Workbench mode 

n Toolbox panel 

n Gradient fills 

System 
Requirements
PC: Windows Vista, 7

or 8 (Desktop mode

is specifically required 

for Windows 8)

Mac: OS X 10.6 or later, 

Intel Mac required

Rating

page://78
page://79
page://80


Features
n Carpenter pencil 

design

n Milled graphite or 

natural walnut

n Tapered tip

Eraser

n Accurate sensor

n 90-minutes charge

for one month’s use

Bluetooth

n USB charging

System 
Requirements
iPad: OS X 10.6 or 

Works with Paper 

and Procreate 2.1 

(connected) or any 

app (non-connected)

Rating

Price £61  Company FiftyThree  Web www.fiftythree.com  Contact support@fiftythree.com

Pencil
Mighty fine Paper, meet Pencil. FiftyThree’s stunning 
new stylus enables you to capture ideas in style

The 3Doodler raised more than two million 
dollars on Kickstarter (of a $30,000 goal).

Making complex objects will take time, patience 
and plastic, but it is doable and rewarding.

Pencil is compatible 
with the Paper app as 
well as Procreate 2.1. 
But it will work as a 
normal stylus with 
any art app.

Pencil is a beautiful stylus – it feels 
like a device built for artists.

he iPad has become the 
digital sketchbook of 
choice for many artists and 
FiftyThree’s Paper is right 

up there with the best apps to use for 
quickly getting down a concept or 
even finishing a piece, be it on the 
move or in the studio. The elegance 
and simplicity of Paper, which 
combines a number of refined art 
tools along with an innovative 
sketchbook-like interface, has made 
it a firm favourite among artists. And 
now, with the appropriately named 
companion stylus – Pencil – there’s 
even more reason to love the app.

Pencil is a beautiful device. Square 
and angular yet ergonomic, it takes the 
tried-and-tested form of a carpenter 
pencil. And it feels wonderful. In fact, 
it’s as if you’re holding a real pencil 
rather than a Bluetooth-enabled digital 

device. After putting Pencil’s tip to the 
screen in Paper, the device is paired. 
You can sketch, scribble and then flip it 
over to erase without changing tools 
– just like you would with your Wacom 
stylus. We couldn’t test all the features 
because we don’t have iOS 8 yet, but 
Apple promises it will add surface 
pressure, meaning you can use the fine 
tip of Pencil for details and the angled 
edge for broader strokes. Also neat is 
the fact that it knows whether Pencil or 
your hand is touching the screen.

Pencil is tool-sensitive in Savage 
Interactive’s Procreate 2.1, with other 
apps coming soon. And of course it will 
work as a normal stylus with any art 
app; you just won’t be making the most 
of it. Charge-wise, you simply pop out 
the battery and plug it into a USB port. 
Ninety minutes will give you about a 
month of use. We’re impressed. 

t

Billed as ‘the world’s first 3D 
printing pen’, the 3Doodler is 
intriguing. With the appearance of 
a glue gun and, well, the feel of a 
glue gun, you may at first be 
convinced into thinking this is 
some kind of glue gun. But it isn’t!

The premise of the 3Doodler is 
ace. Push in a stick of coloured 
plastic (the two types are ABS and 
PLA – for their different properties, 
see http://bit.ly/1AguGhz) switch 
the device to the correct heat 
setting and push one of the two 
buttons, which spit out the plastic at 
two different speeds. Then start 
drawing in 3D. Note that you have 
to keep it plugged into the mains 
during use. The demos on the 
company’s site are impressive and 
we were eager to get drawing.

But it takes a load of practice. We 
struggled to control lines and 
making solid objects even on your 
fifth, 10th or 20th attempt is difficult. 
Where it is fun is if you draw a 
template on paper first, then doodle 
over that, peeling the dried plastic 
off and assembling manually. You 
can make some really cool objects 
and sculptures with the 3Doodler, 
but it’ll take a lot of patience, a lot of 
time and probably a lot of plastic.

Plastic fantastic 
Drawing in 3D is pretty 
hard, but not impossible

Price £99
Company WobbleWorks, Inc
Web www.the3doodler.com

rating 
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Price £25  Company Wacom  Web www.wacom.eu  Contact 020 7744 0831

Bamboo Stylus Duo 2
Pen pal Is it a stylus for drawing and painting on your tablet? 
Is it a pen for sketching in your notepad? Actually, it’s both…

he Bamboo Stylus Duo is a 
neat idea. A touchscreen 
stylus at one end with a 
ballpoint at the other, the 

Stylus Duo is intended to cater for all 
of your portable sketching and note-
taking needs. The idea is you get the 
best of both worlds: you can sketch 
digitally on your iPad or other tablet, 
then flip the pen over (popping the 
lid on the stylus end if you so wish) 
and start doodling in your 
sketchbook or notepad. It’s not 
exactly rocket science, but it is a 
decent idea that will appeal to those 
artists embracing both digital and 
traditional methods.

The stylus has a pleasingly accurate 
tip and it’s undeniably comfortable to 
use. It also looks stylish with a minimal 
design and Bamboo logo on the lid. 
The ballpoint pen itself is said to be 
high-quality – and we can’t argue with 
that. Both stylus and ballpoint tip can 

be easily replaced. The stylus is 
available in six colours to suit your 
taste, but we kept things simple and 
tested the black one. The blue and 
white options look particularly snazzy 
and the anodised aluminium and soft-
touch body are rather nice.

Of course, Wacom touts its Bamboo 
Paper and Bamboo Loop apps as 
perfect companions for the stylus, but 
the truth is you can use any art or 
sketching app. 

There’s not a lot more to say about 
the Bamboo Stylus Duo 2 except it’s a 
stylish, slimline device that kills two 
birds with one stone. Sure, it doesn’t 
have the Bluetooth connectivity of the 
likes of Pencil by FiftyThree, but it is 
inexpensive, comfortable to use, and 
serves a dual purpose.

T

Stylish and handy, the 
Bamboo Stylus Duo 2 is a 
good addition to your 
portable art arsenal.

With Layer Effects you can add drop shadows, 
glows and more by using a familiar panel.

Affinity Designer is powerful and best of all, 
significantly cheaper than Adobe’s Illustrator.

If you want to design or create 
with vectors, most people would 
turn to Adobe Illustrator. But with 
Affinity Designer, one of three 
apps being released by Serif this 
year, Illustrator has a serious 
contender, and one that now 
operates on Macs – a first for 
publisher Serif. 

On launching AD you’re 
presented with a stylish, dark 
interface. In terms of the toolset, it 
rivals Illustrator pretty closely: the 
normal Bézier feature set means 
you can draw precise curves; Layers 
make it possible to organise your 
artwork and edit on an object-level; 
and the Brush tools enable you to 
create custom brushes and apply 
natural-looking vector strokes. 
There’s also some great effects 
tools, including nifty Layer Effects.

But the best thing of all? The 
speed. Affinity Designer is fast (try 
out the beta at the link above). And 
you can work in CMYK mode, 
meaning it can be used not only for 
digital output, but print as well. With 
a flat price of £35 when released in 
October, those looking for a fast, 
powerful vector tool without paying 
a monthly subscription charge (as 
with Adobe) should check it out. 

Attractive vectors 
Can Serif’s new app 
topple the vector king?

Price £35 (on sale in October)
Company Serif
Web www.affinity.serif.com

rating  

Affinity Designer

The Bamboo Stylus 
Duo has two ends: 

one a stylus, the  
other a standard 

ballpoint pen.

Reviews
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Features
n Touch-screen stylus

n Ballpoint pen

n Six colours

n Stylish design

n Exchangeable 

rubber nib/ball-point

n Weight: 16.2g

n Diameter: 8.4mm

n Length: 133mm  

(with cap)

System 
Requirements
iPad/iPhone/Android 

tablet

Rating



Publisher CDW Studios  Price £29  Format Download  Web www.cdwstudios.com

Artist profile

Bryan  
Wynia

Bryan is a senior character artist at 
Hi-Rez Studios. Previously, he 
worked at Sony Santa Monica and 
Naughty Dog, where he 
contributed to God of War: 
Ascension and the Uncharted 
series. He also works as a freelance 
character designer and sculptor. 
Some of his clients include Legacy 
Effects, The Aaron Sims Company, 
Gentle Giant Studios and Masked 
Avenger Studios. His art has been 

featured in Famous 
Monsters of Filmland, 
ImagineFX and 
Ballistic Publishing’s 
Essence: Creatures.

www.bryanwynia.blogspot.com

live format, with an enthusiastic 
audience contributing with some great 
questions. Through these, Bryan 
touches not just on software skills and 
creature design, but also grabs the 
chance to offer career advice and chat 
about the creative lifestyle. He’s 
engaging and funny throughout: the 
time flies by as you watch, and it’s only 
when he’s done that you realise how 
much you’ve learned.

Creature Sculpting for ZBrush isn’t 
for the beginner CG artist – it’s missing 
the broad overview of the interface 
that CDW Studios’ ZBrush for Concept 
Artists series from Ben Mauro includes, 
for example. And with Bryan’s 
background, the training focus is 
inevitably on modelling soft, organic 
forms. However, if you’ve got to grips 
with the basics of making characters 
and creatures in ZBrush and want to 
refine your techniques to the point 
where you can execute your ideas in a 
productive manner, this is a great way 
to take that step up. 

CREATURE FEATURE Character artist Bryan Wynia helps 
you progress from ZBrush newbie to sculpting maestro

here’s no shortage of high-
quality ZBrush video 
training available, so any 
new entry has to offer 

something distinctive. Bryan Wynia’s 
edge is undoubtedly how easy he 
makes everything sound. He has a 
great ability to strip down complex 
ideas to their core, helping you to 
understand them easily.

Early in this Creature Sculpting 
video, for example, he offers a great 
overview of ZBrush’s DynaMesh 
sculpting system and how to get the 
most out of it, with a clever tip to 
quickly even out the distribution of 
polygons through the model in 
seconds. And if you’ve never quite 
understood the point of creating a set 
of subdivision layers for your digital 
sculpture, you will after watching this.

As usual with CDW Studios, the 
video is recorded live during one of the 
company’s workshops. This volume 
follows a single project over three days, 
and shows off the advantages of the 

T

Creature Sculpting 
in ZBrush Vol 1

Bryan combines reference and anatomical 
knowledge to design a creature that not 
only looks cool, but functions correctly.

In Creature Sculpting for ZBrush, Bryan Wynia offers a 
bundle of tips and tricks to make you a better 3D artist.

Inspiration Art tools and training
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Topics covered
n Gathering reference

n Blocking out with 

DynaMesh 

n Silhouettes and 

shapes

n Modelling a bust 

n Adding textures 

n Polypaint tools 

n Lighting basics  

n Rendering layers 

in ZBrush 

n Post-production 

in Photoshop 

n Working efficiently 

Length
236 minutes minutes

Rating

media://vod.creativegroup.futurecdn.net/1ikm6iwKH433k.mp4


Author Patrick J Jones  Publisher Korero Press  Price £20  Web www.koreropress.com  Available Now

Patrick’s discussion of the basics of 
painting can be applied to digital art, 
too. He prefers to use life models over 
photos so that there are no aberrations 
or odd shadows. He sketches his 
models in big square blocks first, then 
fills in large areas such as limbs and 
torsos, before adding the finer details. 
As a result, his heroes and heroines 
feature real-life proportions, and 
neither are they ridiculously muscled 
nor impossibly curvy.

What follows is a series of tutorials, 
mainly detailing Patrick’s creations for 
the IlluxCon illustration convention, an 
event at which he’s given numerous 
masterclasses in creating oil paintings. 
Each article covers a different aspect 
of creating art, ranging from 
techniques in lighting so that images 
don’t look flat and boring, to how to 
improvise and build upon the slightest 
of ideas. Follow the whole book and 
you’ll learn how to paint, or you can just 
skip to specific chapters if you’re 
struggling with a particular aspect.

By the end of the book the reader is 
granted an intimate understanding of 
Patrick’s style and technique, as well as 

Oiled Up Despite their traditional focus, Patrick J Jones’  
tutorials are packed with useful tips for digital artists

atrick Jones’ story is as 
fascinating and dramatic 
as that of one of the 
warriors he creates. 

Inspired by the iconic works of Boris 
Vallejo and Frank Frazetta, he left his 
native Ireland for London, to pursue a 
career in fantasy and sci-fi art.

As the title suggests, Oil Painting 
Techniques is primarily concerned with 
traditional media. However, Patrick has 
grown fond of digital painting, citing 
Corel’s Painter as his favourite piece of 
software. He considers a good 
understanding of both forms to be 
hugely beneficial, and he often uses 
Painter to create rough drafts before 
finishing them on a real canvas.

p

Patrick’s work is 
reminiscent of his art 
heroes Boris Vallejo  
and Julie Bell. 

Patrick draws pencil cartoons and doodles to help 
him warm up, before starting any piece.

his nature as a person – and Oil 
Painting Techniques fills the role of 
autobiography as well as instruction 
manual. It helps that Patrick is a great 
writer with an anecdote for just about 
every image in the book, and he’s often 
as hilarious as he is insightful. He also 
demonstrates a thorough knowledge 
of art history, citing Caravaggio and 
Disney in the same sentence. 

If you wish to make the jump from 
digital to oils it’s an utter must-have, 
but there are important lessons here 
for artists working in every medium.

Rating 
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e’re used to art books 
having something in the 
form of a foreword and 
some slight,  sometimes 

monosyllabic textual curation. Frank 
Quitely’s compilation launches 
straight from the contents page into 
an excerpt from The Physicist and the 
Flying Saucers with little in the way 
of explanation or introduction. It’s a 
blunt approach, but it works.

Frank’s career began with indie 
comics in the mid-90s, and he received 
his big break with Batman: The 
Scottish Connection in 1998. From 
here he went on to work on big titles 
such as The Invisibles, The Sandman 
and DC Universe. Earlier comics were 
inked in black and white, but later ones 
see the use of dramatic contrasting 
colours. His sense of form also 
develops, becoming more 

he recently rebooted Planet 
of the Apes saga has been 
that most unusual of 
things: one that’s taken the 

themes of the original films and 
books, and turned them into 
something relevant to modern 
audiences. This making-of book 
covers both 2011’s Rise of the Planet 
of the Apes and this year’s sequel, 
Dawn of the Planet of the Apes.

Covering a film and its sequel in one 
book is an interesting approach, 
effectively giving you two books for 
the price of one. It’s also a great way to 
compare and contrast the two films: 
Rise is a bio-tech thriller in the Michael 
Crichton mould, and the homeliness of 
protagonist Will’s residence is neatly 
contrasted with the aseptic cleanliness 
of the labs in which he works. Dawn, on 
the other hand, is a dystopian action 

Graphic Ink: The DC Comics  
Art of Frank Quitely

Rise of the Planet of the Apes and Dawn  
of Planet of the Apes: The Art of the Films

Author Frank Quitely  Publisher DC Comics  Price £30  Web www.dccomics.com  Available Now

Authors Sharon Gosling, Adam Newell and Matt Hurwitz  Publisher Titan Books  Price £25  Web www.titanbooks.com  Available Now

Quite Frankly Who needs words when you’ve got page  
after page of awesome comic book art at your fingertips?

Primate Scream Get your stinkin’ paws on this two-in-one  
behind-the-scenes guide to the simians of today’s cinema 

experimental in terms of angles and 
group tableaux. 

As well as sequential art excerpts the 
book is peppered with larger pieces, 
such as covers, on which Frank goes to 
town. These show the artist’s 
understanding of the form: the mere 
image of Batman saving The Joker 
from an attack by Robin tells even  

adventure, building on the first film and 
offering far bigger sets, the creation of 
which is detailed here.

Of course, the real stars of the show 
are the apes themselves. Their design 
is a significant part of this book, and 
there are numerous shots of actor 
Andy Serkis – who plays lead ape 
Caesar – covered in green dots for the 
motion capture technology that he’s so 

W

T

non-Batfans everything they need to 
know about the characters and story.

It concludes with the briefest of 
afterwords from Frank that reveals 
how the book was put together. But 
this is a tome where the pictures do the 
talking – and it’s all the better for it.

Rating  

closely associated with. This is also 
where the book’s only flaw becomes 
apparent: Rise’s apes now look blurry 
and glassy-eyed compared to Dawn’s 
more realistically rendered primates. 
Nonetheless, this is an authoritative 
and insightful look at one of the more 
evolved blockbusters of recent times.

Rating 
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Start painting today! Discover new ways to create art with inspirational  
advice and techniques from the world’s leading digital artists 
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dragon
Eric Velhagen removes the 
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his mind and his art Page 90
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Elisabeth Alba
Location: US
Web: www.albaillustration.com
Email: mail@albaillustration.com
media: Watercolour, pencil

Elisabeth travelled often 
with her family as a child, 
and developed a fondness 
for history and an 
appreciation of different 

cultures. Add to this a love of film, 
literature and all things Disney, and  
you have the key inspirations behind  
the artist’s work. 

One of our 2012 Rising Stars 
competition winners, Elisabeth has gone 
on to illustrate a string of children’s 
books for esteemed publishers such as 
Henry Holt, Scholastic, and Simon & 
Schuster. October will see the artist up 
sticks and leave New York, moving to a 
new home in western Massachusetts.

1  The Monster Realm
Watercolour, matte medium, 

gouache, 9.5x14.5in
“This is a book cover for The Monster 
Realm by Nara Duffie, a young author.  
I also did the interior illustrations with 
pencil, and a map with black ink and 
digital colouring.” 

2  The First Night
Watercolour, coloured pencil, matte 

medium, gouache, 12.5x17.5in
“The stories from One Thousand and 
One Nights are ripe for the imagination. 
This is Scheherazade and the Sultan 
during their first night together, as she’s 
telling her first story.”

ImagineFX crit
“What I like 
about Elisabeth’s 
art is how she 

manages, even in her 
client work, to put her 
own stamp on things. 
Her choices of colour 
and lighting tie her art 
together in a very subtle 
but satisfying way. “ 
Gary Evans,
Staff Writer
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showcasing The FINEST traditional fantasy artists
FXPosé

Email your submissions to fxpose@imaginefx.com
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FXPosé Traditional art

Email your submissions to fxpose@imaginefx.com
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Dan May
Location: US
Web: www.danmay.net
Email: danmayinfo@gmail.com
media: Acrylic

Dan sees himself as “a 
modern narrative painter”. 
A native of Rochester, New 
York, the American 
attended Syracuse 

University, where he earned a BFA and 
began pursuing art as a career. 

“I weave a rich texture of the surreal 
and mysterious into my work. I think  
I have an original, flowing style.” Dan 
also describes his art as “detail-
intensive”, with their “dreamlike ability 
to transcend the natural states of space 
and time”.

His paintings have been exhibited in 
galleries and museums throughout the 
world. He lives and works in Michigan 
with his wife Kendal and son Max.

1  Emerge
Acrylic on wood panel, 12x16in

“As far as technique goes, all of my 
work is done with acrylic paint on wood 
panel. I often use a dry brush technique 
to build textures.”

2  The Reclamation
Acrylic on wood panel, 16x12in

“This is one of a series of images for sale 
as limited edition prints through my 
website, all of which are signed, 
numbered and printed on archival 
Innova Smooth Cotton.”

3  After the Storm
Acrylic on wood panel, 12x16in

“I give many clues within each piece 
explaining what’s going on, but I feel 
that to explain what each piece is about 
or the events that inspired it take away 
from this overall effect.”
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FXPosé

Email your submissions to fxpose@imaginefx.com

Send up to five pieces of your 
work, along with their titles, an 
explanation of your techniques, 
a photo of yourself and contact 
details. Images should be sent as 
300DPI JPEG files. 

Email: fxpose@imaginefx.com 
(maximum 1MB per image) 

Post: (CD or DVD):  
FXPosé Traditional
ImagineFX,
Quay House, 
The Ambury, Bath 
BA1 1UA, England

All artwork is submitted on the 
basis of a non-exclusive 
worldwide licence to publish,  
both in print and electronically. 

submit your 
art to fxposé



3

ImagineFX crit
“Dan’s art leads 
you in with its 
softness. Feathers, 

furs and silk vegetation 
cushion the wandering 
eye. The hard edges are 
found in the detail.  
Eyes are missing, faces 
hidden and uncanny 
scale creates tension.” 
Beren Neale,
Digital Editor
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Boston Figurative 
Art Center

Damon Lehrer explains how his time as a struggling artist in London  
inspired his community workspace in the city of Boston, Massachusetts

Damon founded the Boston 
Figurative Art Center to build 
the community he could 
never find as a young artist 
living and working in London. 

A
s a young painter, in Boston 
and later London, Damon 
Lehrer would live and paint 
in the same studio. During 
those years he was always 

on the lookout for a sense of community 
he could never find: a place where people 
knew his name and understood his work, 
somewhere that valued artistic endeavour 
above economic success. 

Back in Massachusetts, he found 
himself paying rent on an unused studio, 
so he and a group of artists decided to put 
the space to good use and founded Boston 
Figurative Art Center (BFAC).  

“A few of us went out after a drawing 
session,” Damon says, “and talked about 
the drawbacks (useless degree, expense) 

and virtues (useless degree, community) 
of going to grad school for painting. We 
just decided we needed the community 
and could have it for less if we did it 
ourselves. So BFAC was born.”

Events vary from purely social 
gatherings, to drawing and painting 
classes and pop-up lectures, to 
collaborative shows with commercial 
galleries. There’s even a yearly landscape 
and painting trip to Tuscany. 

BFAC now boasts hundreds of 
members and is completely self-sufficient. 
“We try to provide a community for 
people who want to practise this craft in 
an environment that attracts the widest 
range of practitioners. All together in a 
commodious, clubby environment – with 

good music, food and drink, and some 
pretty accomplished art on the walls.”

At the heart of what Damon and 
everyone at BFAC are trying to do is the 
art. He wants to change people’s view of 
figurative art and provide a platform for 
them to polish their figure skills. 

“It’s true that these days a lot of 
figurative art is just bad. But that’s because 
it’s hard to do well and easy to dismiss 
when not done well. Our mission is to 
change the culture around the art of the 
figure, by encouraging people to practise 
it. What mainstream culture sees as 
uncool, traditional and conservative, 
comes alive in our space.” 
For more information about the group,  
visit www.bostonfigurecenter.org.
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Creative Space

HEY YOU! 
Are you a part of 

a regular art class or 
group? Email us at 

mail@imaginefx.com 
if you want to 
feature here!



cutting a  
fine figure

Here are some of the superb  
sketches completed at BFAC

Damon’s painting,  
Art Class, has become 
BFAC’s “mascot image.”

Whether professional  
or amateur, seasoned  
veteran and fledgling 
hobbyist, everyone is 

welcome to join the BFAC. 

BFAC is more than just a drawing group. 
It organises exhibitions with local 
galleries, hosts lectures  – and even a 
yearly drawing trip to Tuscany.

In BFAC’s early days, all members 
chipped in to pay rent. The organisation 
quickly became self-sufficient, and has 
been ever since. 

Former Marvel 
artist Chris Titus  
shows his 
drawing skills. 

A figure 
drawing by 
BFAC founder 
Damon Lehrer. 

Here’s artist  
and illustrator 
Jason Cheeseman-
Meyer’s deft  
line work. 

Artist and 
author Mark 
Penta is a  
BFAC regular. 

A beautifully  
lit piece by 
Boston-based 
illustrator 
Jonathon Nix. 
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Painting an 
original dragon

There’s falconry, so why not dragonry? Eric Velhagen shows  
how removing control leads to fresh ideas and imaginative art

W
hat do dragons do? 
How are they usually 
depicted in art? What 
can I say differently 
about them? 

In the words of the great Winnie the 
Pooh, “Think, think, think, think.” We 
have falconry, so how about dragonry? 
Whether this idea has been explored 
before or not, I don’t know. But I feel it 
has some potential. 

Before I begin, I like to collect my 
thoughts. What am I trying to say with 
this painting and how best can I execute 
that image? It’s very much like a mental 
plan of the steps I’ll take to achieve the 
results I’m looking for. 

I love the surprises and unexpected 
results that happen when either some or a 

lot of control is removed from the process, 
and this is central to how I work. When it 
comes to artistic tools, for me it’s the more 
the merrier. Any brush (make, size, 
model), any kind of palette knives, plus 
rags, fingers and toes (just kidding). 

I do several thumbnails, exploring how 
the idea comes across visually. I follow 
this with some more developed sketches, 
but nothing too time-consuming. 
Another advantage of thumbnailing the 
idea first is that it enables me to 
determine if the idea has any potential 
before taking the time to find reference. 

Working with a simple colour palette,  
a variety of brushes and tools, my tonal 
drawing nearby for referencing value, a 
cup of coffee, Mozart or Led Zeppelin in 
the CD player… I’m ready to start.

Materials

Paints

n Old Holland 

supplemented with, 

Williamsburg, Holbein, 

Mussini, Vasari and 

Maimeri

Surface

n Claessens universal 

primed linen

n Liquitex Gesso

Brushes and  
other tools

n Any and all kinds of 

brushes and palette 

knives, rags, sponges, 

fingers and suchlike

Oils

get your 
resources

See page 6 now!

 
A largely self-taught painter, 
Eric has been fascinated with 
fantasy art, artists and JRR 
Tolkien since childhood. After 

graduating from the Colorado Institute of 
Art, he became a freelance illustrator, 
winning many local advertising awards. 
www.ericvelhagen.carbonmade.com 
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artist insight
Research and 
reference

Artists must have 

reference. It’s very 

important to gather 

some knowledge and 

understanding for 

believability. But I want 

reference to work 

around my idea and not 

the other way: first the 

idea, then reference to 

support it. Learning 

something new often 

produces new ideas 

and in this case it’s 

the dragon’s hood. 

4 Transferring the image
I photocopy my anatomical drawing and apply 

earth-colour pastel to the back. Using a Blending Stump,  
I blend the pastel together and remove any excess so it 
won’t get on to the linen. Then I take a hard-leaded pencil 
and transfer as little of the image as possible, so I’m not 
restricted by it and can push the paint around.

5 Painting set-up
I work on linen because of its irregular weave and 

coarseness (they come in varying degrees of coarseness) 
and for its longevity. I prefer a textured surface because the 
coarseness grabs the paint from the brush. A smooth 
surface doesn’t work for me, so I apply Liquitex Gesso to 
Claessens universal primed linen, in a haphazard way.

2 Anatomical accuracy
A bird of prey’s hood lifts off the head, but that  

won’t work with my dragon, so I concept a hood that slides 
forward. Then I go from sketch to drawing. Because this 
stage is so important for its foundational aspect, I draw and 
redraw the image until I get a sense of anatomical accuracy. 

3 Value drawing
To reaffirm that my anatomical drawing is accurate,  

I convert the line to mass and value. In this stage,  
I also think about the light source, shadowing and 
application of paint. I have some concerns about the hood 
of the dragon and its believability, so I produce several 
variations of the hood design.

1 The dragon’s pose
I don’t want the dragon looking proud and upright 

on the hand of a dragon-handler, like a bird of prey – a quick 
sketch confirms this. Instead, I want mine to look more 
menacing and serpentine. I start researching the sport of 
falconry, which is crucial because I know very little about it.

paint
tip

oil flexibility
Oil paints are awesome 

in the limitless ways they 
can be applied, from very 
thin (like watercolour) to 

very thick.
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artist insight

Yin and yang

One thing I like to 

achieve with my 

paintings is a yin and 

yang quality: wet and 

dry, smooth and course, 

hard verses soft edges, 

detail and suggestion. 

As the painting 

progresses, and seeing 

its needs change, I stay 

flexible and carry out

any adjustments as I 

see fit.

6 Start painting
I strive for my paintings to have the same energetic, 

confident, bold strokes as my thumbnails. I work quickly, to 
have those happy accidents, letting the paint do what it 
wants, then telling me what it needs. I start with a quick little 
experimental study of colour and application technique.

7 Background
I start with the background above and behind the 

dragon’s back. I find the first few strokes very energising, 
especially when I see the direction corresponding with my 
mental image. From there I start on the dragon. I define and 
refine areas before I move on.
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Looking glass
Mirrors are great at 
revealing those little 
problems, and I use a  
mirror throughout my  

art process.
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9 Adding thicker paint
I move on to the lasso, tail and glove. At this point in the painting I feel the oil 

wash is inadequate and that adding thicker paint will help. So I integrate the thicker 
application to the background, using a very simple mask to protect the dragon from 
the background paint.

8 Variety of effects
As I do more on the dragon and hood, I remember 

that one aspect of painting I enjoy is to constantly switch 
paint brushes with other tools. This gives me a nice variety 
of effects and some unexpected results, which add visual 
interest. This makes the painting process more rewarding.
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Finding what 
works for you

As you read about 

different techniques 

used by different 

artists, realise that we 

have found what works 

for us – you need to 

find what works for 

you. We’ve learned 

this by doing it, by 

constantly painting, 

training the eye and 

hand, knowing the 

tools, learning colour 

and value, pushing 

boundaries and always 

having a desire to 

improve and grow.

paint
tip

clean transfer
Avoid graphite or

charcoal as your transfer.
Use a colour that your 
painting will have in it.
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artist insight

Be kind to 
yourself

When evaluating your 

work, never say 

anything like, “That’s 

terrible”, because that 

remark offers no 

solutions. Be kind to 

yourself. Instead, define 

the area or areas that 

aren’t working and say 

something like, “Is the 

value too light or too 

dark?”, “Are the 

proportions off?” or 

“Could it be the overall 

composition?” When 

you ask the right 

questions, the right 

answers come much 

more easily.

12 Final adjustments
All elements are now painted, but there are a lot of 

adjustments to be made. This will take the form of adjusting 
value, edges and colour, and integrating these throughout.  
I’m aiming for a nice, painterly marriage between the 
background and the subject. 

11 Looking for balance
I decide that the upper right part of the image is 

lacking in strength, compared to the lower left, so I add 
more green. I then complete the wing on the left side and 
integrate it with the background. After that I turn my 
attention to the other wing and the lower right 
background area.

10 Making the paint travel 
Because I’ve added purple to the glove, the same 

colour needs to be in the background. Travelling to the 
lower left corner, I employ several techniques, the most 
prominent being to delete with terpenoid and gravity, thus 
enabling the paint to travel where it wants.
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Create mood with 
value composition

Chris Legaspi concludes his excellent series on life drawing by explaining why 
value composition is a powerful tool for capturing the viewer’s attention

Materials
n Canvas or illustration 

board

n Bristle brushes of 

various sizes

n Oil paints: Titanium 

White, Ivory Black

n Solvent or thinner

V
alue composition draws the 
eyes to an image, because it’s 
the first read the mind 
makes. Once I have the 
viewer’s attention, I can use 

composition tricks to maintain their gaze.
I begin a value composition by limiting 

the values I use to two or three. This 
creates clear shapes and a powerful, two-
dimensional graphic read. Then I’ll work 
with value keys. These refer to the range of 
values on a value spectrum. For example, 
low key uses mostly dark values, and high 

key is mostly light values. Low key creates 
a dark and mysterious mood, while high 
key feels lighter and softer. 

My next step is to simplify either the 
shadow or the light side. If both sides 
receive equal attention, then the painting 
will feel flat. To draw attention to the light 
side, I’ll simplify the shadow by grouping 
the darks and ignoring variation in the 
darks. If they’re needed later then I can 
always bring out details in the shadow.

Once my shapes and edges have been 
rendered and refined, and the painting is 

nearly complete, I’ll add the last touches 
of detail on the focal points of the image. 
I’ll add highlights or anything that adds 
contrast at the focal points along with 
more refined edges. Finally, I’ll use design 
elements to draw the eye to a particular 
focal point and then move the eye 
around the canvas.

1 Limiting values
I work with as few values as possible. A reduced number 

of values creates more visual impact because it generates clear, 
two-dimensional graphic shapes. I begin by squinting at the 
subject to simplify the shapes I see. Then I create a series of 
simple, three-value thumbnail based on my observation.

2 Value keys
Value keys help to generate mood, story and drama in a composition. For 

this image I choose to work with a mostly dark, low-key image to create a sense 
of mystery and a feeling of chiaroscuro, or ‘emerging from the darkness’.

Oils

 
Chris is keen to share his 
extensive knowledge of figure 
drawing and painting. See more 
of his work and drawing advice 

at www.learn-howtodraw.com.

Full key

Low key

High key
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Mid-tone shape

Dark shape

Squinting at a subject helps 
to simplify value shapes

Light

Value usedValue used

Value used

Small
dark
shapes

Small light shapesThree-value  
composition

Workshops

get your 
resources

See page 6 now!
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3 Simplify the shadow
Because the image is mostly 

light, I simplify the shadow into one 
large mass of dark. This enables me to 
focus all my rendering and detail on 
the light side. Simplifying the shadow 
also gives more visual weight to the 
light side, which is a good way of 
grabbing the viewer’s attention.

4 Adding variation
Once the major value shapes 

are blocked in, I can add variation. In 
the darks, I apply a gradient from the 
top downwards. In the midtones, 
gradations happen from left to right 
and also in the face and neck. The 
lights graduate from a bright highlight 
on the chest up to the face.

5 Focal points
Because there’s so much 

dark, I use highlights to draw the 
eye to focal points on the face 
and features. Bright highlights 
at the bottom of the canvas 
create dynamic tension in  
the composition. Lines in the 
hair and fabric adds eye-flow 
and movement. 

artist insight
Far out

To improve the

composition, I work as 

far back as possible and 

step away so I can see 

the entire image as a 

whole. I only move in

closer once the 

composition feels right.

Focal point 1

Focal 
point 2

90% 
brightness

80%
brightness

100% 
brightness

Eyeflow to 
focal point 3

Eyeflow to 
focal point 1

Focal point 3
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Transition tones Darkest
dark

Shadow shapes
within light

(lighter
shadow)

Group dark 
fabric with  
the shadow

Dark shadow

Dark
gradient

Midtone
gradient
(left to 
right)

Midtone gradient
(top down)

Small dark
shapes gradient
(light to dark)

Midtone 
gradient 
(dark to 

light)

Light
gradient

Lighter 
shadow

Exercise
Monochrome art

Paint a portrait or figure 
from life using only black 
and white. Stick to three 

values and use value 
keys to create the 

right mood.

Artist insight Value composition
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You're a child, you see a 
painting or drawing that 
changes everything. 
Where are you and what 
are you looking at?

I’m in an attic reading my older cousin's 
discarded collection of comics. I’m 
enjoying the interplay between words 
and pictures to tell a story. On the back 
of these comics I keep seeing a picture of 
Norman Rockwell offering up the 
challenge: “If you can draw Bambi and 
this pirate, we can make you an artist.” 
At 13, I took up that challenge. There was 
a positive response and my parents 
agreed to enroll me into the Famous 
Artist Correspondence Course. I’m still 
drawing pirates today.

Did the area you grew up in affect 
your career in painting or your art?
I grew up in central Connecticut, in a 
small town called Plainville. The local 
school would take us on field trips. One 
was to a quarry in town where I saw huge 
chunks of earth being ground up to 
make paving materials. Seeing a natural 
area being eaten away by machines 
bothered me, and to this day, that sort of 
sacrifice has become a motivator in my 
work. The other trip I remember was to 
the Peabody Museum in New Haven, 

where I saw a 110-foot long mural with 
lots of dinosaurs. The artist who painted 
the Pulitzer Award-winning mural 
would later be one of my teachers.

What was your first paid job, and what 
do you think about it now?
I attended the Paier School of Art and 
sometimes local businesses would offer 
jobs to students. One such business was 
Lenders Bagel Bakery in nearby New 
Haven, which was looking for artists to 
paint faces on mini bagels. Myself and a 
few other art students were approached 
to become bagel painters. The welcome 
income was 25 cents a head and helped 
us with art supplies.  

Around that time, I also had some 
pencil drawings published by Marvel 
Comics as ads. These experiences 
introduced me to advertising and the 
comics industry.

What’s the last piece that you finished, 
and how does it differ from the first?
I just finished a private commission to 
paint an interpretation of Long John 
Silver. The job required me to do a 
watercolour. While I have done a lot of 
watercolour ‘spots’ with no background, 
this was an illustrated scene that offered 
a different challenge. The big difference 
was that no bagels were involved!

How did you come to specialise in both 
myths and maritime painting?
When I left art school, several paintings 
in my first portfolio presentation were 
later published. My first commissioned 
book cover combined fantasy and 
pirates. In 1985, I was invited to be a 
visiting guest instructor at the Ringling 
School of Art and Design in Sarasota, 
Florida. This enabled me to experience 
another part of the country and I began 
imagining buccaneers appearing next to 
palm trees, ships anchored off the 
beaches, pirates coming ashore with 
shovels and such. Creating the original 
art that launched Captain Morgan Spiced 
Rum and several ad campaigns was an 
additional incentive as that association 
with pirates received global popularity. 

Can you name one person who helped 
you on your way?
Jim Aparo, who let me watch him work 
on DC Comics. He critiqued my comic 
art and took me to visit DC Comics 
headquarters in New York City before I 
entered art school. He even let me ink 
some panels of an Aquaman comic he 
was working on. It seems every person I 
have met professionally since has 
enhanced my life.

Is your art evolving? 
I believe each work I do is an evolution. 
I seem to approach my art in different 
ways to complete each task. I'm always 
learning new ways to accomplish end 
results that satisfy the underlying needs 
of the work. I’ve taken to occasionally 
painting on location with oil paints, and 
then adding elements later in the studio. 
Previously, I’ve relied solely on 
photography for background features.

How has the industry of fantasy art 
changed during your career?
When I entered the field, book cover and 
magazine commissions used to be the 
only outlet for realistic fantastic art. Now 
the major blockbuster movies, best-
selling books, video games and most 
watched cable shows have embraced 
fantastic imagery. These are ever-
expanding markets and opportunities.
Don is best known for his Captain Morgan 
character, but he has also twice won the Hugo 
Award for Best Professional Artist, science 
fiction’s highest honour for an artist.   
www.paravia.com/DonMaitz

 I’m always learning new 
ways to accomplish results that 
satisfy the needs of the work 

conjure maitz 
A 1987 oil on maisonite work in 
which a conjurer activates his 
magic circle while his female 
assistants dance around him.

blood and thunder
Don’s love of maritime painting 
is perhaps best reflected in his oil 
on canvas works, such as this 
piece from 1988 featuring some 
of his plundering characters.Im
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Don relates his rise 
from bagel painter to 

acclaimed science 
fiction, fantasy and 

maritime artist 

First Impressions
Don Maitz
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